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Назначение программы 
Программа RawDigger предназначена для просмотра, изучения и анализа RAW-файлов цифровых 

фотоаппаратов и некоторых цифровых кинокамер. 

RawDigger позволяет 

• Просматривать исходные (т.е. до какой-либо обработки) значения пикселов RAW-файла. 

• Экспортировать (в файлы TIFF) RAW-данные. 

• Строить и сохранять поканальные гистограммы RAW-данных, как для всего файла, так и для 

произвольно выбранной прямоугольной области изображения. Сохранение гистограмм 

возможно как в графическом виде, так и в табличном, удобном для последующей обработки. 

• Показывать области переэкспозиции (насыщения) и недодержки в RAW-файле. 

• Рассчитывать поканальную статистику (минимум, максимум, среднее, среднеквадратичное 

отклонение) для всего изображения. 

• Для произвольного количества прямоугольных областей изображения: рассчитывать 

поканальную статистику и сохранять ее в удобном для обработки виде (CSV, CGATS). 

• Сохранять в табличном виде тоновые кривые RAW-файлов (для тех камер и тех форматов 

RAW-данных, где эти тоновые кривые используются). 
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Версии (редакции) RawDigger 
RawDigger  выпускается в нескольких «редакциях», предназначенных для разных групп 

пользователей программы: 

 RawDigger 
Exposure 

RawDigger 
Research 

RawDigger 
Profile 

Пользователи программы Фотографы 
(для оценки 
экспозиции, 
калибровки 
экспозамера и 
освещения и т.п.) 

«Исследователи 
камер» 
Авторы RAW-
конверторов и 
других средств 
работы с RAW 

Построение 
цветовых 
профилей камер 

Открытие (чтение) RAW-файлов 
всех поддерживаемых форматов 

 

+ 
 

+ 

 
+ 

Просмотр RAW во всех режимах 
(RGB, RAW Composite, 
поканальный просмотр RAW) 

 

+ 
 

+ 

 
+ 

Показ областей передержки и 
недодержки 

 

+ 
 

+ 

 
+ 

Показ гистограммы всего файла; 
Статистика всего файла 

 

+ 
 

+ 

 
+ 

Работа с одной выделенной 
областью (Selection): статистика, 
гистограмма. 

 

+ 
 

+ 

 
+ 

Экспорт данных в TIFF  

- 
 

+ 
 

+ 
Работа со многими 
выделенными областями 
(Samples, таблица замеров): 
статистика, гистограмма, 
экспорт в CSV и CGATS 

 

- 
 

+ 

 
+ 

Фильтрация экспортируемых 
данных по замерам: баланс 
белого, нормализация, 
выравнивание (Flat Field), 
фильтрация экстремальных 
значений. 

 

- 
 
- 

 
+ 

Работа с сетками замеров (для 
быстрой обработки цветовых 
шкал) 

 

- 
 
- 

 
+ 
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Системные требования 
Компьютер под управлением Windows (XP SP2+, Vista, 7), 32 или 64-bit, 1GB памяти, CPU с 

поддержкой SSE2 и выше (Intel Pentium 4 и новее). Разрешение экрана 1024x768 и более. 

Mac OS X: Mac на базе Intel, Mac OS X 10.5 или новее. Программа, возможно, работает под OS X 10.4, 

но не тестировалась под этой версией. Поддерживаются 32- и 64-битные системы. 

Установка программы 

Windows 
Установка программы производится путем запуска исполняемого файла дистрибутива (RawDigger-

1.x.x-Setup.exe). 

Если вы скачали RawDigger из Internet, то при первом запуске современные версии Windows 

предупредят вас об этом таким диалогом: 

 

При нажатии кнопки Run, система UAC предупредит вас еще раз: 

 

В обоих диалогах вы можете убедиться, что дистрибутив подписан именно ключом LibRaw LLC. 
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Для продолжения установки необходимо согласиться с изменениями, в этом случае будет запущен 

обычный мастер установки: 

 

На следующих экранах мастера: 

1. будет показана пользовательская лицензия; 

2. предложен каталог (папка) для установки, который можно изменить; 

3. предложена группа в меню «Программы»; 

4. предложен список дополнительных действий: добавить иконку на рабочий стол, добавить 

иконку в меню Quick Launch 

После чего произойдет установка, которая завершится следующим экраном: 
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В случае каких-либо ошибок при установке, обращайтесь пожалуйста в форум технической 

поддержки www.rawdigger.ru/forum 

Mac OS X 
Откройте скачанный дисковый образ (RawDigger-1.x.x.dmg) двойным кликом на иконке скачанного 

файла. На экране отобразится содержимое этого образа: 

 

Перетащите иконку RawDigger «по стрелке» на иконку Applications. Программа скопируется в ваш 

фолдер Applications и станет доступна для запуска. 

На этом же образе диска содержатся: 

• руководство по использованию программы (RawDigger-manual.pdf) 

• Прочие информационные материалы (краткое README, описание истории изменений, 

лицензия на использование, копирайтная информация). 

• В фолдере Licenses – копирайтная информация библиотек и компонентов, использованных в 

RawDigger. 

  

http://www.rawdigger.ru/forum
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Активация программы 
При первом запуске RawDigger покажет Splash-скрин с просьбой активировать пробную версию 

 

После чего покажет диалоговое окно с предложением активировать программу: 

 

После нажатия кнопки Activate Trial программа будет активирована и перейдет в пробный (Trial) 

режим длительностью 30 дней. В течение этого периода пользователю будут доступны все функции 

программы. 

Для использования программы после окончания периода пробного режима необходимо прибрести 

лицензию на использование. 

Чтобы приобрести лицензию , перейдите на сайт RawDigger (по нажатию кнопки Buy License или 

откройте в браузере www.rawdigger.com/purchase.html), и приобретите необходимую вам версию 

лицензии. При покупке вам будет предоставлен лицензионный ключ (online и в E-mail-сообщении, 

которое придет после покупки), который нужно ввести в поле License key диалога активации (диалог 

активации доступен через Menu-Help-Purchase/Activate): 

http://www.rawdigger.com/purchase.html
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Введя лицензионный ключ,  нажмите кнопку Activate license, лицензия будет активирована и вы 

сможете работать с программой дальше.  

Пункт в меню Help-Purchase/Activate переименуется в Help-Registration data, вызываемый им диалог 

будет показывать ваши регистрационные данные: 

 

Для активации (как пробной версии, так и купленного лицензионного ключа) программе необходим 

однократный доступ к Internet. Если разрешить такой доступ невозможно, вы можете 

воспользоваться ручной активацией. 

Ручная активация 
Если при активации не удалось связаться с сервером активации, программа сообщит об этом, а в ряду 

кнопок в правом столбце окна активации появится дополнительная кнопка “Manual Activation”: 
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При нажатии на «Manual Activation, откроется окно ручной активации программы: 

 

В зависимости от возможности доступа к Internet, вы можете использовать один из трех способов 

получения активационного кода: 

By using browser (if your browser has an internet connection)  – используйте этот вариант, если 

Internet-браузер может соединяться с интернетом.  

Просто нажмите ссылку «Click this url: http://activate.rawdigger.com/activate.cgi» и у вас откроется окно 

браузера с активационным ключом: 

http://activate.rawdigger.com/activate.cgi
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By using E-mail client with an automatically prepared message  – нажмите ссылку в этом пункте и у вас 

откроется окно почтовой программы с уже сформированным письмом на activate@rawdigger.com  

Вам нужно только отослать это письмо. 

By using an E-mail client and manually writing the message - вам нужно самостоятельно отправить E-
mail на activate@rawdigger.com с текстом, который подготовлен для вас в окошке ниже (“I’m unable to 
activate….”) 
В двух последних случаях вам в ответ придет E-mail с текстом полностью аналогичным тому, что 

показан в примере с Web-браузером (но activation key будет другим). 

Activation Key из сообщения (полученного в браузере или по E-mail) нужно вставить в поле Activation 

Key (используйте Copy-Paste или будьте крайне внимательны, каждый символ ключа – важен), после 

чего нажать кнопку Activate. 

После нажатия кнопки Close window окно ручной активации закроется и в окне автоматической 

активации будет показан статус регистрации (пробного или полноценного режима): 

 

 

 

mailto:activate@rawdigger.com
mailto:activate@rawdigger.com
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Использование программы 

Запуск  RawDigger 

Windows 

Запуск RawDigger производится стандартным для Windows способом: двойным кликом мышью на 

иконку на десктопе, через меню «Start» («Пуск» в русскоязычных версиях Windows). 

Если программа запущена с дополнительными аргументами командной строки, то первый из них 

воспринимается как имя файла для открытия сразу после старта. Как следствие, если перетащить 

иконку RAW-файла на иконку RawDigger, то программа запустится и откроет перетащенный на нее 

файл.  

Если в программе включен режим «одного процесса» (см. ниже раздел «Настройки»), то в случае, 

когда RawDigger уже запущен, запуск нового процесса RawDigger с именем файла в командной строке 

будет приводить к тому, что переданный файл откроется в окне старой копии программы.  

Открыть новое окно (даже если включен режим одного процесса) можно, запустив RawDigger с 

параметром –newinstance 

RawDigger –newinstance filename 

Mac OS X 

Запуск производится двойным кликом в Applications, либо перетаскиванием иконки RAW-файла на 

иконку программы. 
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Главное окно RawDigger 
В главном окне программы отображается открытый (через меню File->Open) RAW-файл, его 

метаданные, некоторое количество статистических данных. В главном окне выбирается и режим 

просмотра файла. 

 

Главное окно программы c открытым RAW-файлом. Красными цифрами помечены 

информационные блоки и органы управления 

1. Метаданные файла. 

В этом окне показываются 

• Имя файла (в заголовке окна) 

• Производитель и  тип камеры 

• Экспопара (значения выдержки и диафрагмы), чувствительность 

• Режим замера и экспопоправка (если была при съемке) 
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• Название объектива 

• Использованное фокусное расстояние 

• Кнопка EXIF в этом информационном блоке открывает окно с EXIF-данными файла (см. 

ниже). 

2. Поканальная статистика по RAW-данным. 

В заголовке блока: размеры изображения в пикселах. В самом блоке: минимум, максимум, 

среднее (Avg) и среднеквадратичное отклонение (σ) значений пикселов в каждом из цветовых 

каналов. 

3. Поканальная статистика для последней выделенной области. 

В заголовке блока: координаты верхнего левого и размеры выделенной области (X-Y-W-H). В 

самом блоке: минимум, максимум, среднее и среднеквадратичное отклонение значений 

пикселов в каждом из каналов внутри выделенной области. 

4. Координаты указателя мыши и RAW-значения под ним. 

В заголовке блока – координаты указателя мыши (X-Y), в самом блоке – значение в пикселе 

или 4-х пикселях под указателем (режим показа, 1 пиксель или 4, определяется в окне 

настроек, см. ниже раздел «Настройки (Preferences)»). 

5. Режим показа изображения: 

• RGB render– показывается RGB-отображение с выбранным (см. ниже описание 

настроек) балансом белого. Для камер, где aspect ratio отдельного пикселя отличается 

от 1 (например, некоторых камер Fujifilm) этот режим будет недоступен 

• Raw composite – для RGB(G)-raw - такое RGB-изображение, где зеленый канал получен 

смешением двух зеленых каналов RAW.  Для всех прочих RAW-файлов (CMYG, RGBE и 

т.п.) показывается grayscale-изображение, значения пикселов которого берутся из 

соответствующих каналов. 

• Raw Channel – выбранный канал показывается в черно-белом режиме. 

• OvExp – включает индикацию переэкспонированных областей изображения (красным 

цветом). 

• UnExp – включает индикацию недоэкспонированных областей изображения (синим 

цветом)  

6. Статистика областей переэкспозиции/недодержки в файле. 

Для каждого цветового канала показывается сколько пикселей находится в области 

переэкспозиции (в штуках и в процентах от общего количества пикселей данного цвета в 

файле), а сколько – в области недодержки. 

7. Индикация вычитания уровня черного при обработке RAW-данных 

На кнопке показаны текущие значения уровня черного: Auto (вычитание уровня, сообщенного 

камерой, равен значению Black Level в информационном блоке №1), Off (вычитание не 

производится), Manual+значение – используется одинаковое для всех каналов значение, 

заданное в настройках, 1-4 значения в скобках – используются индивидуальные значения для 

каждого канала. 

При нажатии на кнопку вызывается диалог настроек (см. ниже раздел «Настройки»), открытый 

на закладке «Data Processing»). 

8. Индикация использования тоновой кривой при обработке RAW-данных 

Индикатор на кнопке имеет значения Normal (используется стандартная тоновая кривая, 
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содержащаяся в RAW-файле, если она там имеется), Linear (используется линейная «кривая» с 

единичным наклоном) и N/A (для данного открытого файла настройка не имеет смысла). При 

нажатии на кнопку вызывается диалог настроек (см. ниже раздел «Настройки»), открытый на 

закладке «Data Processing»). 

9. Управление масштабом изображения 

Кнопки + и – изменяют масштаб, в выпадающем меню «Fit To Window» можно выбрать 

масштаб из списка. 

10. Выбор кадра (для многокадровых RAW): 

Выпадающий список позволяет выбрать кадр для показа. Для файлов, где содержится только 

один кадр (большинство RAW-форматов), этот элемент интерфейса будет недоступен. 

11. Блок управления яркостью RGB-представления 

Этот блок управляет яркостью RGB-представления путем увеличения гаммы на указанную 

величину (от 0 до 3, суммарная гамма будет, соответственно, от 2.2 до 5.0). Данный способ 

увеличения яркости – увеличивает яркость теней и полутонов за счет сжатия светов. 

12. Контекстное меню открывается по правой кнопке мыши на выделениях (Selection) и замерах 

(Sample) и позволяет удалить выделение/замер, показать/спрятать гистограмму и 

преобразовать выделение в замер. 

 

В заголовках полей статистики всего изображения и статистики по выборке могут присутствовать 

дополнительные индикаторы: 

• [M] в заголовке окна статистики изображения сигнализирует, что включен режим показа «черной 

рамки» (masked pixel – область сенсора, не формирующая изображение) и статистика по черной 

рамке включена в общую статистику изображения. 

• [F] в заголовке окна статистики по выборке сигнализирует о том, что включен режим фильтрации 

экстремальных данных (см. ниже раздел Настройки – Data Processing). 
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Работа с главным окном 

• Перемещение указателя мыши позволяет посмотреть значения пикселов (RAW-данных) под ним. 

Для «байеровских» RAW-файлов (т.е. таких, где пиксель содержит данные только для одного 

цветового канала), в зависимости от режима показа (см. раздел «Настройки (Preferences)» ниже), 

показываются либо значение данных конкретного пиксела (остальные 3 компонента – нулевые), 

либо значения пикселов всех 4-х цветовых каналов для того квадрата размером 2x2 пиксела, над 

которым находится указатель мыши. 

Для полноцветных RAW-файлов показываются значения всех трех (четырех) каналов. 

• Нажатие Alt-левая кнопка мыши приводит к простановке «замера» (Sample) фиксированного 

размера. Размер замера задается настройками программы (см. ниже раздел «Настройки 

(Preferences)»). Ранее поставленные замеры выделены на изображении серым полупрозрачным 

фоном с зеленой окантовкой. Работа с ними описана ниже, в разделе «Окно Samples» 

• Нажатие Shift-Левая кнопка мыши позволяет выполнить прямоугольную «выборку» (Selection) 

произвольного размера. Один угол выборки фиксируется в момент нажатия кнопки мыши, второй 

– по отпусканию кнопки Shift. Одновременно может существовать только одна «выборка», но она 

может быть превращена в «замер». Работа с выборками описана ниже, в разделе «Меню 

программы – меню Selection». 

• Нажатие левой кнопки мыши на изображении позволяет двигать все изображение в окне. 

• Нажатие левой кнопки мыши  на выделении/замере позволяет двигать выделение/замер по 

изображению 

• Правая кнопка мыши на выделении/замере вызывает контекстное меню: 

o Delete – уничтожает замер/выделение 

o Show/Hide Histogram – показывает/убирает гистограмму по данному замеру/выделению. 

o Convert Selection To Sample (только для выделений) – преобразует Selection в Sample т.е. 

помещает данные о выделении в «Окно Замеров» (см. ниже). 

• Drag and Drop – RAW-файл можно перетащить из Windows Explorer в окно программы, он будет 

открыт, как если бы он был выбран через меню File->Open. 
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Индикация переэкспозиции/недодержки 

Если в окне Display включить чекбоксы OvExp (индикация переэкспозиции) и/или UnExp (индикация 

областей недодержки), то области с выбитыми светами/недодержаными тенями будут показаны 

красным/синим цветом: 

 

Настройки индикации переэкспозиции/недодержки (какие области будут подсвечены) – в диалоге 

«Настройки» (Preferences) в разделе Over/Under Exposure (см. ниже). 
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Окно EXIF 

Окно EXIF-данных показывается 

• По кнопке EXIF в информационном блоке метаданных 

• Через Menu – Windows – EXIF 

В окне EXIF отображаются метаданные файла, извлеченные программой Exiftool: 
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При помощи поля ввода Filter: можно отфильтровать показываемые поля по подстроке (подстрокам): 

 

В поле Filter можно вводить регулярные выражения (в формате PCRE), например Width|Height 

отфильтрует все строки, в которых содержатся подстроки Width или Height. Поиск в данных EXIF 

осуществляется без учета регистра символов. 

В нижней части окна EXIF находятся кнопки закрытия окна и копирования EXIF-данных в Clipboard: 

• Copy to Clipboard (text) скопирует EXIF-таблицу в текстовом формате 

• Copy to Clipboard (HTML) скопирует в HTML-формате (с форматированием) 

Настройка Copy full table включается если используется режим фильтрации данных: если данную 

галочку отметить, то кнопки копирования будут копировать в clipboard полную таблицу EXIF-данных, а 

не результаты фильтрации. 
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Меню программы  

Меню File 

• Open – открывает RAW-файл. Если файл открыть не удалось (неподдерживаемый формат, 

поврежденный файл), будет продолжена работа с ранее открытым файлом. 

Если для текущего файла существуют замеры, данные которых не сохранены, программа 

предложит сохранить их до открытия нового файла. Координаты существующих замеров и 

выборки будут сохранены, если они полностью попадают в размеры вновь открытого файла. 

Иные замеры и выборки будут удалены. Для оставшихся – статистические данные будут 

пересчитаны на основе значений из вновь открытого файла 

• Next file – открывает следующий RAW-файл в каталоге. Порядок сортировки задается 

настройками (Misc. Options – File order). Если «следующего» файла нет, программа пищит. 

• Prev File – открывает предыдущий RAW-файл в каталоге. 

• Close File – закрывает открытый файл, позволяя безопасно извлечь  сменный носитель: 

o освобождает память 

o закрывает все открытые окна 

o меняет текущий каталог на %HOME%/Pictures (если такой есть) или на %HOME% 

Предназначено для освобождения сменных носителей (флеш-карт и т.п.) без закрытия 

RawDigger 

• Export Tiff – позволяет экспортировать данные открытого RAW-файла в формате Tiff (см. ниже 

раздел «Экспорт данных»). 

• Dump RAW curve – этот пункт меню активен только для тех RAW-файлов, при распаковке 

которых используется тоновая кривая. Используя данный пункт меню, эту тоновую кривую 

можно сохранить в CSV-формате для последующего изучения 

• Screenshot – позволяет сохранить изображение главного окна программы в формате PNG или 

JPG. По умолчанию сохраняется формат PNG, для сохранения в JPG нужно указать это 

расширение явно в диалоге выбора файла для сохранения. 

Это действие недоступно в меню при включенной опции Preferences – Misc. Options – Use 

OpenGL for bitmap draw. 

• Preferences – вызывает диалог настроек, описанный ниже в разделе «Настройки 

(Preferences)» 

• Exit – выход из программы. Если есть несохраненные данные по «замерам», программа 

предложит сохранить их 

• Помимо перечисленных стандартных пунктов меню, программа запоминает последние 5 

открытых файлов, список которых показывается в меню File. 
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Меню View 

Меню View дублирует элементы управления масштабом изображения, расположенные на нижнем 

крае главного окна программы: 

• Zoom In  увеличивает изображение. 

• Zoom Out – уменьшает его. 

• Normal Size  устанавливает масштаб 100% (1:1) 

• Fit To Window масштабирует изображение так, чтобы оно помещалось в окно программы. 

• Fullscreen: переводит RawDigger в полноэкранный режим 

Меню Window 

Меню Window включает/выключает показ дополнительных окон программы: 

• Histogram – Гистограммы всего изображения (см. ниже раздел «Гистограммы RawDigger») 

• Samples Window – Таблицы замеров (см. ниже раздел «Таблица замеров (Samples)»). 

• EXIF – окно EXIF 

Меню Selection 

Меню Selection позволяет совершить следующие действия над выделенной областью: 

• Clear Selection – удаляет выделенную область 

• Selection Histogram – открывает окно с гистограммой выделенной области (см. ниже раздел 

«Гистограммы RawDigger») 

• Convert Selection to Sample (Ctrl-M)– преобразует выделение (Selection) в замер (Sample) и 

помещает в список замеров (см. ниже раздел «Таблица Замеров (Samples)»). 

• Set Selection by Numbers – позволяет точно задать положение выделения, введя в диалоговом 

окне положение верхнего левого угла и размеры: 

 
При выборе «галочки» Center selection on image, параметры Left и Top становятся 

неактивными и автоматически ставятся в такие значения, чтобы выделение было 

расположено по центру изображения. 

• Selection Grid – используется при работе со снимками цветовых шкал, см. раздел «Selection 

Grid» ниже. 

Меню Help 

В меню Help содержатся такие пункты: 

• Supported Cameras   - показывает список камер, поддерживаемых данной версией RawDigger 
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• Check for updates – запускает проверку наличия обновлений для программы. 

• Registration data (для полноценной лицензии) или Purchase/Activate (для пробного режима) 

– показывает диалог активации лицензии 

• Technical Support forum – открывает браузер со страницей форума поддержки. 

• Contact Support – открывает браузер с формой обратной связи. 

• About – показывает информацию о версии программы, доступных обновлениях и т.п. 

Горячие клавиши (Shortcuts) 

Windows 

• Ctrl-O – открывает файл (Menu->File->Open). 

• Ctrl -> (стрелка вправо) – открывает следующий файл (Menu -> File -> Next file) 

• Ctrl <- (стрелка влево) – открывает предыдущий файл (Menu -> File -> Prev file) 

• Сtrl-E – открывает диалог экспорта данных (Menu -> File -> Export Tiff) 

• Ctrl-P – вызывает диалог Preferences (Menu->File->Preferences). 

• Ctrl-Q – выход из программы (Menu->File->Exit). 

• Ctrl-+, Ctrl-= – увеличивает загруженное изображение (Menu->View->Zoom-In). 

• Ctrl-- - уменьшает изображение (Menu->View->Zoom-Out). 

• Ctrl-S – 100% масштабирование изображения (Menu->View->Normal Size). 

• Ctrl-F – масштабирует изображение, чтобы оно влезло в окно программы (Menu->View->Fit to 

Window). 

• Ctrl-H – вызывает/прячет окно гистограммы изображения (Menu->Window->Histogram). 

• Ctrl-L – вызывает/прячет окно с таблицей замеров (Menu->Window->Samples). 

• Ctrl-M – преобразует текущее выделение в замер (Menu->Selection->Convert Selection to 

Sample). 

Mac OS X 

Те же горячие клавиши, что и на Windows, но вместо Ctrl-клавиша используется Command-клавиша. 

Единственное исключение – вызов окна гистограммы, где используется Option-H а не Command-H. 

Гистограммы RawDigger 
Меню Window->Histogram показывает окно с поканальными гистограммами, построенными по всем 

данным файла.  

Гистограммы RawDigger имеют следующие особенности: 

1. Горизонтальный масштаб может быть как линейным (по значениям в RAW), так и 

фотографическим (линейным по шкале EV, т.е. каждый шаг шкалы вдвое больше предыдущего). 

Горизонтальная ось имеет обе оцифровки: линейная под гистограммой и фотографическая, над 

гистограммой 

2. Вертикальный масштаб может быть как линейным, так и логарифмическим 

3. Столбики (бины) гистограммы всегда имеют ширину, равную целому количеству пикселов с 

целью уменьшения алиасинга (муара). Как следствие, при автоматическом выборе ширины 

столбика (бина) гистограмма занимает от ½ до полной ширины окна и не может быть 

масштабирована произвольно. 
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4. Все 4 поканальные гистограммы имеют одинаковый масштаб. 

5. Если файл содержит не 4 цветовых канала, а меньше, то на месте гистограмм неиспользуемых 

каналов рисуются серые прямоугольники. 

Окно гистограммы содержит элементы управления гистограммой, показанные на рисунке: 
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Окно гистограммы. Красными цифрами помечены элементы управления, описанные ниже. 

1. Save CSV – сохранение гистограммы в виде CSV-файла, пригодного для дальнейшей обработке 

(например, в Microsoft Excel). Сохраняются данные по бинам гистограммы, с учетом текущих 

настроек (ширина бина, режим работы и т.п., см. ниже). 
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2. Save PNG – сохранение гистограммы в виде графического файла (PNG или JPEG, для 

сохранения в JPEG необходимо явно указать для сохраняемого файла расширение .jpg или 

.jpeg). 

3. Save Full Data – сохранение необработанных данных гистограммы без объединения в бины: 

значение уровня сигнала и число пикселов с этим значением. 

4. Управление отображением гистограммы в линейном режиме 

В линейном режиме горизонтальный масштаб одинаков по всей горизонтальной оси. В этом 

режиме основную часть графика занимают света и, в меньшей степени, полутона 

изображения, а область теней сжата около левого края гистограммы. 

Элементы управления линейным режимом: 

• Linear X-axis – включает линейный режим 

• Auto – включает автоматический подбор минимума-максимума по горизонтальной 

оси и ширины бина гистограммы 

• Bin Size – задание ширины бина вручную (задается количество уровней в одном бине). 

• Range – задание отображаемого диапазона горизонтальной оси. 

5. Управление отображением гистограммы в фотографическом режиме 

В фотографическом режиме горизонтальный масштаб линеен относительно ступеней 

фотографической экспозиции (т.е. единиц экспозиции, Exposure Value, EV). Каждая ступень, 

независимо от ее положения на тоновом диапазоне снимка (тени, полутона, света) занимает 

одинаковое расстояние по горизонтальной оси гистограммы. 

В области теней возможных уровней может быть меньше, чем задано размером бина 

гистограммы. Так, например, «3-я снизу» фотографическая ступень изображения 

соответствует значениям от 4 до 7 включительно, таким образом разных уровней всего 4. В 

этом случае часть бинов будет иметь нулевую высоту, а в гистограмме будут «дырки». 

Элементы управления фотографическим режимом: 

• EV-scale X-Axis – включает фотографический режим 

• Auto – включает автоматический подбор ширины бина и отображаемого диапазона 

гистограммы 

• Bin size – задание ширины бина вручную, в долях от 1EV (фотографической ступени) 

• Range – задание отображаемого диапазона горизонтальной оси 

• Update Linear Scale – если эта опция включена, то изменение диапазона для 

фотографического режима отображения будет менять и линейный диапазон. 

6. Управление показом шкалы EV 

Шкала EV (фотографические стопы) показывается в виде сплошных вертикальных линий в 

поле гистограммы.  

Элементы управления: 

a. Show EV Grid – включает/выключает показ шкалы по EV 

b. Auto – включает автоматический расчет нуля шкалы (положения серой точки).  Ноль 

шкалы размещается на уровне «3 стопа (8 раз) ниже, чем максимальное значение 

пиксела, округленное вверх до ближайшей степени двойки». Например, если 

максимальное значение среди всех пикселов снимка равно 3000, то ближайшая 

бОльшая степень двойки  - 4096 и уровень EV0 для данного снимка будет 

автоматически установлен на уровне 512. 
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Максимум может отсчитываться как от максимального значения пикселов в 

изучаемом снимке (стандартное значение), так и от теоретически возможного 

максимума для данной камеры. Включить второй вариант можно в разделе настроек 

«Histograms»  настройкой Set histogram EV0 by  (см. Ниже раздел «Настройки») 

c. 0 EV at – позволяет задать значение уровня для EV0. При использовании 

фотографического режима отображения гистограммы, изменение EV0 изменяет и те 

данные, которые попадают в отображение, как следствие меняется вид гистограммы. 

d. EV tick – позволяет задать шаг сетки EV (1/3, 1/2EV, 1EV, 2EV).  

7. Управление вертикальной шкалой: 

Для управления вертикальной шкалой используются следующие элементы управления: 

a. Auto – автоматическое задание верхней границы диапазона (нижняя – всегда 0), таким 

образом, чтобы все столбики помещались. 

b. Grid – отображать горизонтальные линии сетки на графике. 

c. Scale – задает тип вертикальной оси: 

i. Linear – линейный масштаб, 

ii. Logarithm – логарифмический масштаб, высота столбика гистограммы 

пропорциональна log(значение+1), 

iii. Square root – высота столбика пропорциональна квадратному корню из числа 

пикселей в данном бине. 

d. Max -  значение максимума вертикальной оси, может быть задано только при 

выключенном режиме Auto. 

8. Статистические данные по гистограмме: 

a. Min/Max – минимальное/максимальное  значение пикселей данного цвета (канала) 

b. Pixels – количество пикселей данного цвета в области, по которой построена 

гистограмма. 

c. Values – количество разных значений пикселей в данном цветовом канале.   
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Таблица замеров (Samples) 
В окне Samples показана таблица «замеров», произведенных по файлу: 

 
Окно Samples.  

В таблице замеров показывается, слева направо: 

• Координаты верхнего левого угла и размер замера (в формате X-Y-Width-Height) 

• Номер замера 

• Для каждого из цветовых каналов: минимум (min), среднее (avg), максимум (max) и 

среднеквадратичное отклонение (dev) по площади замера. 

Цвет фона ячеек таблицы соответствует цветам каналов файла. 

Цвет шрифта соответствует цветам шрифта в информационных окнах главного окна (минимум – 

синий, максимум – зеленый, среднее и дисперсия – черный шрифт). 

Одна или несколько строк таблицы могут быть выделены (для выделения нескольких строк – укажите 

их мышью, удерживая нажатой кнопку Ctrl). Выделенные строки имеют синий фон (см. рисунок) 

Если какие-либо строки выделены, то соответствующие им замеры на главном экране программы 

начинают мигать. 

В верхней части окна, над списком замеров, расположены элементы управления: 

1. Save Samples – позволяет сохранить все значения из списка замеров (см. ниже раздел 

«Сохранение таблицы замеров») 

Append File – активизируется, если сохранение замеров уже происходило в течение сессии 

работы с программой и выбранный формат допускает пополнение. Если отметить этот 

чекбокс, то кнопка Save Samples  меняет название на Append File,  при сохранении замеров не 
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запрашивается новое имя файла, а ранее созданный файл пополняется. Опция Append File 

активизируется только если предыдущий файл данных сохранялся в формате CSV (см. ниже), 

для формата CGATS дополнение файла замеров невозможно 

2. Histogram – открывает окна с гистограммами для всех выделенных строк таблицы. 

Гистограммы показываются только для замеров, содержащих более 25 пикселов 

3. Remove Sel – удаляет выделенные строки и соответствующие им замеры на главном экране, 

закрывает окна с гистограммами по замерам, если таковые окна были 

4. Sel. to Clipboard – копирует выделенные строки в Clipboard (буфер обмена) в виде таблицы. 

Если включена галочка Header to Clipboard, то в буфер обмена копируется и заголовки 

столбцов таблицы. 

5. Remove All Samples – кнопка удаляет все замеры из таблицы (и с главного экрана программы). 

6. Load – загружает координаты замеров из ранее сохраненного файла (см. ниже «сохранение 

таблицы замеров). При загрузке – нужно выбрать ранее сохраненный файл и, при 

необходимости сохранить существующие замеры, снять галочку Clear existing samples. 

Работа с таблицей замеров возможна только в версиях RawDigger Research и RawDigger Profile.  
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Сохранение таблицы замеров 

При сохранении таблицы замеров пользователю показывается следующее диалоговое окно: 

 

Окно сохранения таблицы замеров 

Помимо стандартных элементов диалога, служащих для задания имени сохраняемого файла, данное 

окно содержит дополнительные настройки, управляющие сохранением таблицы замеров: 

1. Блок File Format позволяет выбрать формат сохраняемого файла: 

• CSV – сохранение в формате Comma Separated Values, этот формат удобен для 

последующего анализа данных в Excel и подобных программах 

• CGATS – сохранение в формате «Committee for Graphic Arts Technologies Standards», этот 

формат используется, в частности, в программах построения цветовых профилей. 

• Flat Field Data – записывает файл с описанием неравномерности сигнала сенсора камеры. 

Данная неравномерность возникает за счет неравномерности освещения мишени и 

различных видов виньетирования. 

Чтобы получить данные о неравномерности сфотографируйте ровную, 
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нетекстурированную, монохромную (лучше – бесцветную: белую или серую) матовую 

поверхность (толстая белая бумага или пластик вполне годятся, если удастся расположить 

их плоско). Эта поверхность должна быть расположена поверх снимаемой (на следующих 

шагах) цветовой мишени или вместо нее. Используйте то же самое освещение, положение 

камеры, объектив, его фокусировку и значение диафрагмы. Использование той же 

чувствительности (ISO) – полезно, особенно если шумовые характеристики камеры сильно 

меняются с изменением ISO.  

Значение выдержки необязательно иметь тем же самым, что и при съемке цветовой 

мишени, ее следует поставить такую, чтобы получить наибольшую точность, при этом не 

имея переэкспозиции ни в одном из цветовых каналов.  Мы рекомендуем экспонировать 

эту ровную поверхность с экспопоправкой +1.5EV относительно показаний экспонометра в 

центровзвешенном или точечном режимах. 

Как и всегда при съемке мишеней, жесткий штатив и тросик (или беспроводное 

управление) сильно упрощают работу. 

Данные о неравномерности поля, если они есть, могут быть использованы при 

преобразовании данных о цветовой мишени (см. ниже), что позволяет избавиться от 

большинства проблем, связанных с неравномерностью освещения.  

Данные хранятся в специфичном для программы RawDigger формате. 

• Coordinates only – сохраняет файл с координатами замеров (с расширением .RDS), этот 

файл потом может быть загружен кнопкой Load в окне замеров. 

2. Блок Additional Data Fields позволяет указать, какие поля данных включать в сохраняемый файл: 

• Raw Filename – включать имя файла;  

• Raw Frame Number – включать номер кадра внутри RAW-файла;  

• Cell Coordinates – включать в отдельных столбцах таблицы координаты верхнего угла, 

ширину и высоту выбранной области;  

• Min/Max Values – включать минимальные/максимальные значения; 

• StdDev – включать значения стандартного (среднеквадратичного) отклонения; 

• Average Green Channels – усреднить значения двух зеленых каналов (опция активна 

только для RGBG-файлов). 

Название замера, его номер и средние значения по каждому из каналов включаются в 

сохраняемый файл в любом случае. 

• Camera vendor/Camera model – включает в выходной CSV-файл поля с производителем и 

моделью камеры. 

• Shutter value/Shutter string – в выходной CSV-файл будут включены данные о выдержке: 

i. Shutter value – выдержка в секундах (например 0.01). 

ii. Shutter string – выдержка «в красивом форматировании» (например 1/100). 

• Aperture value/Aperture string – в выходной CSV-файл будут включены данные о 

диафрагме: 

i. Aperture value – числовое значение (например 5.6) 

ii. Aperture string – красивое строквое значение (например f/5.6) 

• ISO – в выходной CSV-файл будет записано значение чувствительности ISO 
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• Add DESCRIPTOR “DCP Profile” – при включении этой галочки, в выходной CGATS-файл 

будет добавлена строка DESCRIPTOR “DCP Profile”. Эта строка предназначена для 

переключения программы BasicColor Input в режим генерации DNG-профиля. 

3. Блок Flat Field Normalization – позволяет задать файл Flat Field (сгенерированный ранее) для 

корректировки неравномерности поля мишени. 

• Flat Field Datafile – имя файла с данными 

• Average Channels – усреднить поканальные данные FlatField. 

• Match Flat Field Data by Sample Name – данные о равномерности поля мишени 

сопоставляются с текущей таблицей замеров не по номерам строк, а по именам полей 

мишени. 

4. White Balance – выходные данные будут скорректированы (домножены на коэффициенты 

баланса белого) таким образом, что замер, заданный в поле Sample ID станет «серым». Как 

правило, цветовые шкалы содержат подходящий патч (один или несколько). 

Баланс белого производится путем подбора коэффициентов на которые умножаются цветовые 

значения, таким образом, что средние значения в цветовыъ каналах  на выбранном замере 

(патче) станут равны. 

Данный способ балансирования белого может использоваться только на RGB (RGBG) камерах. 

Эту настройку нельзя включить для одноканальных (черно-белых) RAW-файлов. 

5. Data Scaling and Gamma – выходные данные будут гамма-корректированы и масштабированы: 

• Gamma Value – значение Gamma (в диапазоне от 0.1 до 4.0) 

• Maximum Value – максимальное значение данных (среднего значения по замеру) в 

выходном файле. 

Обработка данных (Flat Field Normalization, White Balance и Data Scaling and Gamma) доступна только в 

версии RawDigger Profile. 
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Selection Grid: работа с цветовыми шкалами 
При цветовом профилировании камер бывает нужно снять замеры сразу с большого количества 

элементов цветовой шкалы. Это можно делать ручной установкой выборок (Selections) с 

последующим преобразованием их в замер (Sample), но в RawDigger предусмотрен более 

производительный и удобный режим работы с цветовыми шкалами. 

Работа с сеткой доступна только в версии RawDigger Profile Edition. 

«Сеточная» выборка вызывается через меню Selection->Selection Grid, при выборе этого пункта на 

экране появляется диалоговое окно, управляющее параметрами сетки: 

 

Параметры этого окна: 

• Grid Size: размер сетки в ячейках 

• Minimum cell size: минимальный размер ячейки сетки (в пикселах), при интерактивном 

изменении размеров сетки программа не даст сделать ее элемент меньше, чем данная 

величина. 

• ROI relative size: размер «активной» части ячейки сетки (ROI:  Region of Interest). Замер 

(данные для усреднения) производится по центральной части ячейки сетки, показанной на 

экране красным прямоугольником. Размер ROI указывается в долях от полного размера сетки 

(прорисованной серым цветом). 

• Группа кнопок Grid settings (см. ниже сохраниение/загрузка параметров сетки): 

o Save to file – сохраняет текущие параметры в файл. 

o Load from file – загружает параметры сетки из файла  
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• На закладке Cell Naming 

расположены элементы 

управления именованием 

ячеек сетки: 

o Start from corner: 

стартовый угол, где 

расположена 

первая ячейка 

o Walk order: 

порядок обхода 

(по строкам или по 

столбцам) 

o Naming order: один из 7-ми видов именования ячеек 

o Show Cell ID/Name on Grid: показывать ли имена ячеек на экране  

• Place Grid:  размещает сетку на экране программы 

o Use loaded position – использовать позицию сетки, если она была загружена из файла 

(эта галочка будет доступной только если позиция сетки была успешно загружена). 

• Remove Grid: удаляет сетку с экрана программы 

• Selection to Samples: заполняет таблицу Samples (удаляя оттуда старое содержимое если 

установлена галка Clear Old Samples) 

• Hide Grid Controls: убирает диалог управления сеткой с экрана. 

После нажатия кнопки Place Grid, в основном окне программы появляется сетка. Всеми ее 

параметрами кроме Grid Size можно управлять через диалоговое окно. 

 



RawDigger – руководство пользователя 

Стр. 34 из 90 © Copyright 2012-2023, LibRaw LLC, www.libraw.com 

Саму сетку можно двигать по экрану: 

• Перемещение углов: 

o С нажатой левой кнопкой мыши перемещается один угол. 

o Ctrl+левая кнопка мыши: происходит изменение размеров 

• Drag всей сетки: левой кнопкой мыши в середине сетки. 

После нажатия кнопки Selection to Samples в диалоге Grid Parameters в таблице замеров появляются 

сделанные замеры, имена которых соответствуют именам ячеек сетки: 

 

С этими замерами можно поступать обычным образом (сохранять в CSV или CGATS, удалять строчки 

из таблицы, строить гистограммы по избранным замерам и т.д.). 
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Параметры диалога управления сеткой запоминаются между запусками RawDigger. 

Сохранение/загрузка параметров сетки 

Кнопка Grid Settings – Save to File: 

• Запишет в файл (с расширением RGS) параметры сетки прямо вот как они сейчас установлены в 

диалоге настройки сетки (Grid Size, Minimum cell size…). 

• Если сетка размещена на изображении, то будут записаны координаты ее углов. 

Кнопка Grid Settings – Load from File: 

• Активна только если сетки на экране нет (если есть – используйте кнопку Remove Grid) 

• Прочитает из RGS-файла все параметры диалога установки сетки – и установит их. 

• Если в RGS-файле были записаны координаты сетки с экрана – прочитает и их и галочка Use loaded 

position под кнопкой Place Grid – станет активной. 

Кнопка Place Grid с установленной галочкой Use loaded position: 

• Если пиксельные размеры открытого в настоящий момент файла в точности совпадают с 

сохраненными в файле параметров сетки: сетка будет установлена в точности как записано, «по 

пикселям». 

• Если размеры текущего файла отличаются от того, для которого была записана сетка: сетка будет 

установлена по относительным координатам. 

При восстановлении сетки из сохраненных координат: видимая область экрана прокручивается так, 

чтобы сетка была видна (актуально при работе с большим увеличением). 
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Экспорт данных в виде растрового изображения 
Экспорт данных позволяет сохранить в файл формата TIFF следующие данные 

• Результаты RGB-рендеринга 

• Все цветовые каналы RAW-файла в один TIFF-файл (1-,3- или 4-канальный) 

• Один цветовой канал RAW-файла в монохромный TIFF-файл 

При вызове экспорта данных (Menu->File->Export Tiff) пользователь видит следующее диалоговое 

окно: 

 

Параметры этого диалога, расположенные под строкой ввода имени файла, управляют экспортом 

данных: 

Блок Data задает тип экспортируемых данных: 

1. RGB Render: будет произведен экспорт RGB-представления. 

Этот тип экспорта будет недоступен (пункт диалога станет серым и недоступным для выбора), 

если RGB-представление открытого в RawDigger файла не было построено. 

При выборе пункта RGB Render блоки управления Raw processing и Bayer processing options 

будут недоступны. 

Если в главном окне программы выбрана настройка Brighten, то осветлен будет и 

экспортируемый RGB-файл. 
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Данные будут экспортированы в TIFF-файл (8 или 16 бит, в зависимости от настройки 16 bit 

output): 

a. Одноканальный (Grayscale), если работа производится с RAW-файлом с черно-белой 

камеры. 

b. 4-канальный (программы работы с TIFF воспримут его как CMYK) если работа 

производится с 4-цветным RAW-файлом (RGBE, CMYG и т.п.) и в настройках указано 

«Display RGB Render in RAW colors». В этом случае значения в файле будут 

инвертированы, «белое» будет иметь значение 0, черное 255, как это и положено для 

CMYK-файлов. 

c. 3-канальный RGB-файл во всех остальных случаях. 

 

2. RAW composite – в файл экспорта будут записаны RAW-данные всех цветовых каналов файла. 

Данные будут обработаны в соответствии с настройками в группах Raw processing и Bayer 

processing options (для байеровских RAW). 

Данные будут записаны в 16-битный TIFF-файл: 

a. Grayscale-файл (одноканальный) для одноцветных RAW 

b. Grayscale-файл (одноканальный), если для байеровского RAW в блоке Bayer processing 

options выбран режим «Single layer (grayscale) pixel map» 

c. 3-канальный (RGB) файл для 3-цветных RAW и для 4-канальных RGBG-файлов, если в 

настройках Raw processing указан 3-channel (RGB) output. 

d. 4-канальный файл (воспринимаемый другими программами как CMYK) в остальных 

случаях. 

3. Raw channel (и указание цветового канала для экспорта) – в выходной файл будет записан 

один цветовой канал RAW-файла. 

Запись производится в 1-канальный (Grayscale) 16-битный TIFF-файл. 

Блок Raw processing описывает преобразования, которые будут сделаны при экспорте RAW-данных: 

1. 3-channel (RGB) output – включает усреднение двух зеленых каналов для RGBG-файлов. 

Эта настройка недоступна для не-RGBG-файлов. 

2. Autoscale to use full 16-bit range – значения пикселов  RAW-данных будут умножены на 

коэффициент,  чтобы занять весь диапазон значений в 16-битном выходном файле. 

Для YCbCr-данных (см. описание настройки Show YCbCr data for Canon sRAW files в разделе 

Настройки ниже) каналы Y и Cb/Cr масштабируются с разными коэффициентам. 

Во всех остальных случаях коэффициент масштабирования одинаков для всех цветовых 

каналов файла. 

3. Apply gamma 2.2 curve – при включенной опции в файл экспорта записываются гамма-

корректированные данные, при выключенной – линейные. 

Autoscale и гамма-коррекция выдают приближенные (округленные до целого) значения, эти режимы 

следует использовать только для визуальной инспекции данных. Если экспортируемые данные 

планируется численно анализировать каким-либо образом, предпочительно писать в выходные 

данные неизмененные данные (т.е. все опции блока Raw processing – выключены). 
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Блок Bayer processing управляет выводом данных для байеровских RAW-файлов с паттерном 2x2. Для 

всех прочих (одноцветных, linear DNG, Canon sRAW) этот блок недоступен пользователю. 

1. Half Size – будет экспортирован TIFF-файл половинного размера, данные цветовых каналов 

будут составлены из байеровского блока 2x2 

2. 2x2 pixels – будет экспортирован файл полного размера, но значения пикселов в блоках 2x2 

будут одинаковы. 

3. Fill missing values w/ zeroes – будет экспортирован файл полного размера, но заполнены в нем 

будут только те значения, которые содержались в исходных данных, остальные компоненты 

пикселов будут нулевыми. 

4. Single layer (grayscale) pixel map – будет экспортирован одноканальный (grayscale) файл 

полного размера, каждый пиксель которого содержит данные соответствующего ему пикселя 

матрицы. Информация о цвете пикселя, таким образом, будет утеряна. 

Данный режим предназначен для использования с камерами у которых с сенсора удалены 

цветные светофильтры (т.е. изначально цветные камеры, переделанные в монохромные). 

Дополнительные параметры: 

1. Uncompressed TIFF – включает сохранение несжатого TIFF-файла.  

2. 16-bit output: экспортировать RGB-рендер в виде 16-битного TIFF (RAW composite/RAW 

channel записываются в 16-битном виде в любом случае). 

Эта опция доступна только в 64-битной версии RawDigger в связи с ограничениями по 

доступной памяти. 

3. Add EXIF tags from RAW file – включает копирование блоков EXIF из исходного RAW в 

экспортируемый TIFF-файл. 

4. Embed ICC profile – в выходной файл (только для экспорта RGB rendering) будет включен 

цветовой профиль, описывающий данные. 

5. Open exported file with default application – экспортированный файл будет открыт 

приложением, ассоциированным с расширением .tif в вашей системе. 

Экспорт данных в TIFF-формате доступен только в версиях RawDigger Research и RawDigger Profile. 

Работа с данными с плавающей точкой 
Начиная с версии 1.2 RawDigger поддерживает DNG-файлы, содержащие данные с плавающей точкой. 

Этот формат данных используется для сохранения HDR (High Dynamic Range) данных рядом программ, 

которые делают склейку нескольких кадров с фотокамеры в один файл с увеличенным динамическим 

диапазоном. 

В отличие от обычных «целочисленных» RAW-файлов, диапазон значений пикселов в файлах, 

содержащих данные с плавающей точкой, может быть очень маленьким (например, 0…1.0), либо, 

наоборот, очень большим (0-1000000). Использованный диапазон данных не влияет на дальнейшую 

обработку таких данных и авторы программ, создающих такие файлы, могут выбрать этот диапазон 

достаточно произвольно. 

Поскольку внутреннее хранение данных в RawDigger – целочисленное и 16-битно, при чтении данных 

с плавающей точкой необходимо преобразовать их в этот формат. Если диапазон значений во 
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входном файле слишком мал, либо слишком велик, необходимым становится масштабирование 

входных данных т.е. умножение всех входных значений на какой-то коэффициент. 

Это масштабирование управляется блоком настроек Floating point data normalization в Preferences – 

Data Processing 

 

Если реальный диапазон данных в открытом файле или указанный в метаданных файла максимум 

данных (тег WhiteLevel в DNG) выходит за диапазон “below XXX or above YYY”, то все значения 

пикселов в файле будут умножены на один и тот же коэффициент, подобранный так, чтобы максимум 

реальных данных в файле был равен значению ‘Scale data range to’. 

В случае, если при открытии файла выполнялось такое масштабирование данных, RawDigger известит 

об этом в строке состояния программы сообщением ‘FP data normalized: значение коэффициента на 

который были умножены данные’: 
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Будьте внимательны: в результате масштабирования статистика и гистограмма «нормального» и 

«недодержаного» файла могут выглядеть одинаково, потому что к недодержаному применялся 

больший коэффициент масштабирования. 

Настройки (Preferences) 
Окно настроек доступно через меню File или через нажатие Ctrl-P в главном окне программы. 

Доступные настройки объединены в три закладки (Tabs): 

• Display Options – параметры, влияющие на показ данных, но не влияющие на RAW-значения. 

• Data Processing – параметры, влияющие на RAW-значения, показываемые программой. 

• File handling – параметры, влияющие на обработку файлов (открытие, переход к следующему, 

итп).  

• Misc Options – параметры, влияющие на поведение программы (сохранение позиций окон и т.п.). 

• Over/Under Exposure – параметры, влияющие на индикацию областей передержки и 

недодержки. 

Независимо от открытой закладки, кнопки внизу окна Preferences ведут себя одинаково: 

• OK – закрывает окно настроек, сохраняет их в Windows Registry и применяет к текущему 

загруженному изображению, если таковое есть. 

• Cancel – закрывает окно настроек не изменяя и не сохраняя их. 

• Apply – сохраняет измененные настройки и применяет их к текущему открытому изображению, 

окно настроек не закрывается. 

• Reset Defaults – устанавливает значения полей окна настроек в «стандартное» состояние. 
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Закладка Display Options 

 

Окно настроек RawDigger: Display Options 

• Default Display Mode – задает режим показа, который будет установлен при открытии очередного 

файла. Возможные значения: 

• Last Used – режим, который использовался для предыдущего файла 

• RGB render – будет показываться результат обработки RAW (если для открытого файла 

этот режим недоступен по какой-то причине, то будет выбран режим Raw composite) 

• Raw composite – будет показано RGB или Grayscale представление всех каналов Raw-

файла (см. ниже пункт Display RGBG in grayscale). 

• Raw Channel 1 .. Raw Channel 4 – указанный канал Raw-файла будет показан в grayscale. 

• RGB render White Balance – баланс белого, используемый при генерации RGB-представления.  

Этот параметр никак не влияет на отображение RAW-данных в блоках информации об 

изображении и выделенной области, гистограммах, таблице замеров. 

Возможны три значения баланса белого: 

• Daylight – баланс для дневного света (параметры баланса «зашиты» в программу, для 

каждой камеры отдельно) 

• As Shot – баланс белого, замеренный камерой в момент съемки 

• Auto – баланс белого по усредненным данным всего снимка. 
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• Camera color profile – цветовой профиль, используемый при генерации RGB-представления (опять 

же, никак не влияет на отображение RAW-данных): 

• No profile (raw color) – выключает преобразование цвета из пространства камеры в sRGB. 

Для 4-цветных камер (CMYG, RGBE и т.п.) показ этих данных в окне RawDigger невозможен, 

но файл с «исходными цветами камеры» можно получить через экспорт данных (см. выше 

раздел экспорт). 

• Built-in – будет использован цветовой профиль, встроенный в RawDigger 

• Embedded in RAW – будет использован цветовой профиль, записанный в RAW-файл. Таки 

профили записывают не все камеры, если профиля нет, то будет использован профиль, 

встроенный в RawDigger. 

• RGB rendering color space – с вариантами sRGB (default), Adobe RGB, Wide Gamut RGB, Prophoto 

RGB. Получившееся изображение выводится на экран "как есть" (RawDigger не использует color 

management), настройка Adobe RGB может быть полезна пользователям Wide gamut мониторов, а 

две другие - тем, кто хочет видеть менее насыщенные цвета. 

• Visible area crop mode – видимая (немаскированная) область изображения: 

• Minimal: минимальный кроп: показывать максимальную видимую область, с 

минимальной обрезкой черных рамок. 

• Basic vendor crop: кропить в соответствии с базовыми рекомендациями производителя 

(для DNG: по тегам DefaultCrop*, для остальных форматов - в соответствии с 

метаданными) 

• User crop: кропить еще больше. Для DNG это тег DefaultUserCrop (его умеют писать, 

например, камеры Leica если вы кропите в камере), для других форматов: многие камеры 

реализуют кроп подобный "16:9" только записью дополнительного поля в метаданных, 

RAW записывается целиком, Basic vendor crop не меняется, просто добавляется тег "а это 

16:9". В частности, это особенность камер Fujifilm 

• Raw Display Options – управление отображением в режиме RAW 

Эти параметры, как и параметры RGB-отображения, влияют только на показ изображения, но не 

«на цифры». 

• Masked Pixels – включить показ маскированной части сенсора камеры, не 

принимающей участия в формировании изображения (некоторые производители 

вместо «Masked Pixels» используют название «Optical Black»). Эта часть сенсора 

закрыта от падающего света, что позволяет оценить уровень шума в самых глубоких 

тенях, уровень banding, рассчитать уровень черного. Невидимые (маскированные) 

пиксели включаются в RAW-изображение не на всех камерах. 
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• 2x2 Pixels – растягивает каждый одноцветный (байеровский) пиксель на размер 2x2, 

что позволяет получить изображение более похожее на результат после 

дебайеризации. На рисунке ниже виден результат  выключения данного параметра: 

 
Показ белого поля в режиме RAW с включенным режимом 2x2 Pixels (слева) и с 

выключенным (справа). 

Выключенный режим 2x2 Pixels больше «соответствует реальности» для байеровского 

сенсора, но при этом подвержен муару при отображении, тяжелее воспринимается 

зрением, результирующая картинка гораздо темнее. 

На картинке выше белое поле выглядит зеленым т.к. баланс белого не используется 

при показе в режиме RAW, а зеленый канал (у большинства камер) более 

чувствителен, чем остальные цветовые каналы. 

Эта настройка игнорируется (считается выключенной) для файлов, у которых каждый 

пиксель содержит данные для всех цветовых каналов файла (полноцветные и черно-

белые RAW). 

• Gamma 2.2 – включает гамма-коррекцию для RAW-данных. Без такой коррекции 

изображение выглядит темным 

• Autoscale – включает автоматическое масштабирование RAW-данных на диапазон 

яркости монитора. Без такого масштабирования изображение в режиме показа RAW 

будет выглядеть очень темным. 

• Display RGBG in grayscale  - в режиме Raw composite пиксели каналов RAW будут 

показаны не в «своем» цвете, а в серой шкале. Этот режим несовместим с режимом 

2x2 pixels. 

Если показываемый файл имеет Raw-каналы отличные от RGBG, то в режиме показа 

Raw Composite будет производиться grayscale-показ, независимо от настроек Display 

RGBG as Grayscale. 

Для полноцветных (не байеровских) RAW-файлов данная настройка всегда считается 

выключенной. 

• Mouse Pointer – параметры показа RAW-значений под позицией мыши. 

• 2x2 Active Area – если эта опция включена, то в окне показа значений под указателем  

мыши  отображаются значения пикселов в квадратике 2x2 вокруг указателя (у 

байеровского сенсора в таком квадратике содержатся пиксели всех 4-х каналов). 
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Если опция выключена, то показываются значения только того пиксела, над которым 

находится указатель, а остальные 3 компонента будут нулевые. 

Эта настройка игнорируется (считается выключенной) для файлов, у которых каждый 

пиксель содержит данные для всех цветовых каналов файла (полноцветные и черно-

белые RAW). 

• Automatic exposure correction for RGB render – включает автоматическую коррекцию яркости RGB-

представления 

• Allow autoexposure to clip % (highlights) – управляет автоэкспозицией (количеством 

пикселей, которые автоэкспозиция отправит в насыщение). 

• Override white level – позволяет задать свой уровень белого для RGB-рендеринга, все значения 

выше этого уровня будут уменьшены до уровня белого. Позволяет избавиться от эффекта 

«розовых облаков» для тех камер, где уровень белого определяется неверно (например, для 

камер, неизвестных RawDigger). 

• Disable RGB Rendering for files larger – запрещает RGB-отображение для слишком больших файлов 

т.к. RGB-рендеринг может занимать слишком большое время. 

• Disable processing for files larger than NN Mbytes of RAW data – запрещает загрузку слишком 

больших RAW-файлов, чтобы не выйти за ограничения по доступной памяти 

  



RawDigger – руководство пользователя 

Стр. 45 из 90 © Copyright 2012-2023, LibRaw LLC, www.libraw.com 

Закладка Data Processing 
Параметры в этом блоке влияют на отображение RAW-значений в окнах со статистическими 

данными, гистограммах, таблице замеров. 

 

Окно Preferences: Data Processing 

• Subtract Black – вычитать «уровень черного» (т.е. значение «темнового тока», dark current). Какое 

именно значение вычитать – устанавливается в блоке «Black Level» (см. ниже) 

• Linear Raw Curve – использовать линейную тоновую кривую вместо нелинейной. Этот параметр 

имеет значение только для тех камер и форматов данных, где для линеаризации RAW-данных 

используется тоновая кривая и эта кривая задана в EXIF-данных файла (к таким камерам относится 

заметная часть фотокамер Sony). 

• Selection/Sample stats: discard abnormal pixel values – если эта настройка включена, то при 

расчете статистики по выборке (Selection) или замеру (Sample) будут отброшены 10% самых 

больших и 10% самых маленьких значений. 

Этот режим предназначен для автоматической фильтрации аномальных значений (грязь, блики) 

на снимках цветовых мишеней при построении таблиц замеров для профилирования камер. 

Этот режим доступен только в версии RawDigger Profile 

• Black Level – настройки режима вычитания черного. 

o Auto – уровень черного будет установлен автоматически. В зависимости от формата файла 

он будет либо считан из EXIF-данных, либо рассчитан по черной рамке 
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o Manual – уровень черного устанавливается вручную, одинаковый для всех каналов 

o Per Channel – уровень черного устанавливается вручную, для каждого канала отдельно 

o Reset Black Level values on File Load – при открытии следующего файла уровень черного в 

полях ввода для Manual и Per Channel будет установлен в значение, соответствующее 

варианту Auto, после чего его можно  будет менять вручную. 

При установленном автоматическом вычитании уровня черного, RawDigger понимает задание уровня 

черного в больших блоках (до 64x64) через теги BlackLevelRepeat* в DNG (и аналогичные по смыслу 

теги в файлах с сенсоров Fuji X-Trans).  

При  задании уровня черного вручную (общего или по цветовым каналам) вышеупомянутые сложные 

паттерны задания уровня черного – не применяются. 

• Группа Floating Point Data Normalization: 

o For data maximum below … or above … - задает диапазон данных с плавающей точкой, 

при попадании в который данные не будут масштабироваться 

o Scale data range to – задает целевой максимум данных при использовании 

масштабирования 

Подробнее см. выше раздел «Работа с данными с плавающей точкой» 

Закладка Data Processing -> Vendor Specific 
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• Sony ARW2 processing options – включает специальные режимы обработки сжатых с потерями 

файлов Sony ARW2 (cRAW): 

o Processing mode: 

▪ Standard processing – данные раскодируются обычным образом 

▪ Only base pixels – в выходные данные записываются значения только базовых 

пикселов (минимальное и максимальное значение для каждого из цветовых 

каналов в горизонтальном 32-пиксельном блоке). «Дельта-пикселы» (которые 

закодированы в файле как приближенное отклонение от минимального 

значения) – обнуляются. 

▪ Only delta pixels – в выходные данные записываются только значения «дельта-

пикселов» (с прибавленным «базовым» значением), базовые пикселы – 

обнуляются. 

▪ Delta pixels relative to zero – в выходные данные записываются только 

значения отклонений «дельта-пикселов» от базового значения, само базовое 

значение не прибавляется. 

▪ Delta step relative to value – в выходные данные выводится отношение шага 

дельты к RAW-значению в данном пикселе. Это значение рассчитывается в 

промилле (тысячных долях). В тех участках изображения, где значения этого 

отношения большие, а вариация данных мала – возможна постеризация. 

o Ignore shadows below level – не рассчитывать/не показывать Delta step relative to value 

в областях изображения, где RAW-значения ниже указанного (в теневых областях  

минимальный шаг данных относительно велик и постеризация там возможна всегда, 

данный параметр позволяет не показывать эту очевидную постеризацию, дабы не 

замусоривать вывод). 

Включение любого режима Processing Mode кроме Standard processing запрещает 

использование библиотеки RawSpeed.  

Включение режима «Delta pixels relative to zero» выключает использование RawSpeed 

и вычитание уровня черного, включает линейную тоновую кривую. 

• Canon/Nikon sRAW/Small RAW – группа настроек, отвечающая за обработку данных в файлах 

Canon sRAW и Nikon Small RAW (оба формата хранят данные в представлении YCbCr, поэтому 

настройки одинаковы): 

o Show YCbCr data for Canon/Nikon sRAW files – выключает преобразование  YCbCr-

данных, содержащихся в файлах формата Canon sRAW и Nikon D4s Small Raw, в RGB-

представление. При этом канал Y декодируется «как есть»; для Canon sRAW  из 

значений каналов Cb/Cr вычитается значение 8192 (при этом для ахроматических 

данных значения Cb/Cr оказываются в середине диапазона значений для канала Y).  

К значениям в каналах Cb/Cr не применяется гамма-коррекция, вне зависимости от 

установок этого параметра в закладке Display Options. 

o Do not interpolate Cb/Cr channels data (Canon/Nikon sRAW) 

Cb/Cr каналы в sRAW-файлах задают данные не во всех точках (каждый четвертый или 

каждый второй пиксел). Перед конверсией в RGB цветовые данные Cb/Cr – 

интерполируются. 

Данный параметр настройки выключает эту интерполяцию. 
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Параметр действует при включенной опции Show YCbCr data for Canon/Nikon sRAW 

files. 

• PhaseOne – обработка файлов PhaseOne (форматы IIQ и EIP) 

o Phase One RAW postprocessing – включает обработку (постпроцессинг) RAW-файлов с 

камер PhaseOne на основании метаданных файла (в этом формате в метаданных 

может содержаться карта плохих пикселей, корректировочные кривые для половинок 

матрицы, данные для корректировки виньетирования). 

Эта настройка не влияет на показ RGB-представления (RGB render), которое всегда 

рассчитывается с включенным постпроцессингом. 

• Pentax K3-II – настройки, специфичные для Pentax K-3 II 

o Merge data for 4-shot frames – включает режим объединения 4 кадров в один, если 

исследуемый файл снят в данном режиме. 

• Sigma dp2 Quattro – настройки обработки данных для файлов камеры Sigma dp2 Quattro 

o R and G channel interpolation включает размножение пикселов в каналах R и G (каналы 

с половинным разрешением)  в квадратик 2x2. 

o Low sensitivity pixel intepolation  - включает нормализацию пикселов с         

пониженной чувствительностью в каналах R и G (в камере dp2 Quattro каждый 64-й          

пиксел в каналах R и G имеет чувствительность ниже приблизительно на 2 стопа.         

Для чего используются эти пикселы - неизвестно, возможно для контроля экспозиции         

в переэкспонированных областях). 

• Panasonic – обработка файлов Panasonic (формат RW2) 

o Filter bad pixels on Panasonic files – включает фильтрацию плохих пикселов на файлах с 

камер Panasonic и некоторых других (сами камеры отдают в этих пикселах нулевые 

значения). 

• Nikon Coolscan NEF – обработка NEF-файлов, полученных в программе Nikon Coolscan (с 

фильм-сканеров Nikon) 

o Coolscan NEF gamma – позволяет установить значение гаммы, соответствующее 

параметрам, установленным при сканировании. 

• DNG files – обработка файлов DNG 

o Apply DNG Opcodes: какие опкоды (коррекции) DNG применять для получения RAW-

изображения. 

o Additional image types – включает показ (возможность выбора) дополнительных 

изображений из DNG (Выбор производится селектором Frame в нижней строке 

программы): 

▪ Enhanced image – Enhanced DNG (созданного Adobe Camera Raw/Lightroom).  

▪ Preview – изображения низкого разрешения 

▪ Transparency masks – маски прозрачности 

o RawDigger перечисляет фреймы (изображения) в порядке следования в структуре DNG, 

дерево IFD/SubIFD обходится в порядке «сначала вглубь». 
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Закладка Histograms 
В этой закладке расположены настройки, отвечающие за режим отображения гистограмм 

 

• Histogram Scale – задает горизонтальную шкалу, которая будет использована при открытии 

окна гистограммы: 

o Last Used – будет использован режим, использованный в предыдущей гистограмме. 

o EV Scale (Photo) – будет использована фотографическая шкала (шкала EV) 

o Linear Scale – будет использована линейная шкала. 

• Remember scale ranges – включает запоминание использованных настроек окна гистограммы 

(диапазон значений, режим показа, сетки по горизонтальной и вертикальной осям).Если эта 

опция включена, то запоминается последнее изменение сделанное в любом из открытых окон 

гистограммы. Настройки используются при открытии нового окна с гистограммой, изменение 

параметров у одной гистограммы не влияет на другую уже открытую. 

• Histogram for RGBG bayer images – задает количество показываемых поканальных гистограмм 

для обычных байеровских изображений с паттерном 2x2 (2 зеленых, по одному красному и 

синему пикселу в квадратике 2x2): 

o Display G1 and G2 – будут показаны отдельные гистограммы для двух зеленых 

каналов. 

o G1 only – гистограмма второго зеленого канала показана не будет. 

o Average G1 and G2 – будет выведена усредненная гистограмма в которой: 
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▪ Высота столбиков – усредненная по двум каналам. 

▪ Минимум и максимум в статистике – минимум и максимум по двум каналам. 

▪ Количество уникальных значений – максимальное значение по двум каналам. 

▪ Количество пикселов – усреднение по двум каналам. 

• Additional data in Histogram title bar – включает отображение дополнительных данных о 

снимке в заголовке окна гистограммы 

o None – дополнительные данные не выводятся. 

o Exposure data – выводятся экспозиция и использованная чувствительность. 

o Camera model – выводится производитель и модель камеры. 

o Exposure & Camera – и экспозиционные данные и модель камеры. 

• Set Histogram EV0 by – задает максимальное значение, относительно которого рассчитывается 

автоматический уровень EV0 (на 3 стопа ниже максимума): 

o Current frame data – берется максимальное значение в текущем открытом файле. 

o Camera data range – берется максимальное значение исходя из разрядности 

(теоретического диапазона данных) камеры. (Некоторые камеры могут не 

использовать весь возможный диапазон; на некоторых камерах диапазон меняется 

с изменением установки чувствительности). 

• Set linear histogram auto range – задает способ установки автоматического (включенная 

галочка Auto) диапазона шкалы в линейном режиме гистограммы: 

o Current frame data – будет использован реальный диапазон значений кадра 

o Camera data range – будет использован диапазон от 0 до максимального возможного 

значениия для данного формата данных (Некоторые камеры могут не использовать 

весь возможный диапазон; на некоторых камерах диапазон меняется с изменением 

установки чувствительности). 

• Histogram area font family: позволяет выбрать шрифт для графической области гистограммы. 

• HiDPI histogram window mode – включает удвоенное разрешение при выводе гистограмм в 

окно. Режим предназначен, в первую очередь, для HiDPI-экранов Apple Mac. 

• High resolution histogram PNG export – включает удвоенное разрешение при экспорте 

гистограмм в PNG-файлы. 

• (Только Windows) Histogram windows always on top of main window –включает режим, при 

котором окна гистограммы располагаются всегда поверх главного окна. 
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Закладка File Handling 
В этой закладке расположены настройки, влияющие на открытие/обработку файлов 

 

• If next file load fails, move current filename pointer forward – разрешает дальнейший переход к 

следующему файлу (действиями Menu – File – Next/Prev File или шорткатами) после неуспешной 

загрузки файла тем же способом. 

• Warn about unsaved Samples on File Open/Exit.  

Включает/выключает предупреждение о том, что в окне замеров остались несохраненные 

данные. 

• Remember Working Folder – запоминает каталог (папку) из которого был открыт последний RAW-

файл, следующие открытия/сохранения данных будут начинаться в этом каталоге. 

Если эта настройка включена, то рабочий каталог будет установлен и при следующем запуске 

RawDigger. 

• Unload opened file before loading new one – при включении этой настройки, перед открытием 

нового файла,  ранее открытый будет закрыт и вся выделенная память – освобождена.  

Этот режим предназначен для работы с очень большими (более 40-50Mpix) Raw-файлами.  

При использовании этого режима Selection/Samples удаляются при закрытии ранее открытого 

файла. 

• Use native system file open/save dialogs where possible – в диалогах открытия/записи файлов (за 

исключением диалогов с дополнительными параметрами) будут использоваться «системные» 

диалоги (такие как в Windows Explorer/Mac Finder) 
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• File Sort order for Next/Prev – задает порядок сортировки файлов для операций Next file/Prev file: 

• Name – сортировка по имени файла. 

• Modify time – сортировка по времени создания/изменения файла. 

• Size – сортировка по размеру файла. 

• Unsorted – файлы сортируются операционной системой (обычно – по порядку появления в 

каталоге). 

• Use natural sort order – при сортировке по имени файла будет использована натуральная 

сортировка числительных (т.е. порядок файлов a1.ext a2.ext a10.ext). При выключенной настройке 

будет использована алфавитная сортировка (a1.ext a10.ext a2.ext). 

• Siderbar folders in Save dialogs - позволяет выбрать набор фолдеров, показываемых в левой 

колонке в диалогах  сохранения файлов (экспорт RAW-данных, сохранение таблицы замеров). 

Возможные варианты: 

• Remember used folders: будет показывать список каталогов,  использовавшихся ранее для 

сохранения файлов. 

• Standard list:  Desktop, Documents, Pictures, TEMP, Home folder 

•  только Home folder  

• Additional RAW extensions – дополнительные расширения файлов для использования в диалоге 

открытия файла и в операциях Next/Prev . Указаваются маски имен файлов, разделенные 

пробелом (например, *.tif *.bin). 
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Закладка Misc. Options 
В этой закладке расположены настройки, влияющие на поведение программы, но не влияющие 

впрямую на процессинг и отображение данных. 

 

Окно настроек Raw Digger: закладка Misc. Options 

• Save windows positions on exit – запоминает положение и размер всех окон программы при 

выходе из нее. При последующем запуске позиции окон будут восстановлены. При новом запуске 

программы открывается только главное окно, но при открытии окон с гистограммами или 

таблицы замеров – они будут спозиционированы правильно. 

• Use Regional Settings for decimal separator – Включает использование системных настроек 

десятичного разделителя (Control Panel – Regional Settings – Country) при сохранении CSV/CGATS 

файлов. Если в качестве десятичного разделителя указана запятая, то разделителем полей в CSV-

файлах будет точка с запятой. 

При выключенной настройке «Use Regional Settings…» в качестве десятичного разделителя будет 

использована точка. 

• Run single Program Instance (только на Windows, на Mac этот режим  - включен всегда и 

обеспечиваетмя операционной системой) – включает режим, запрещающий запуск новых 

процессов (копий) программы. В этом режиме: 

• Если новый процесс RawDigger запущен с указанием имени файла в командной строке – 

файл будет открыт в старом окне программы. 
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• Новый процесс RawDigger сразу завершится. 

• Faster program close (только Windows) – включает ускоренное завершение программы (все 

ресурсы освобождает операционная система). 

• Use small fonts in information panels – уменьшает размер шрифта и промежутки между 

информационными панелями в верхней части окна программы. Предназначена для экранов с 

низким разрешением. 

• Put grid setip dialog on top of all windows – помещает окно Grid Setup поверх всех окон всех 

запущенных программ. Опция срабатывает после перезапуска RawDigger. 

• Minimize subwindows together with main window – если эта настройка включена, то при 

минимизации главного окна будут минимизированы и все остальные окна. 

• Use OpenGL for bitmap draw – при включении этой настройки для вывода изображения будет 

использован OpenGL. Это может работать быстрее на компьютерах со старыми CPU. 

• Данная настройка недоступна в Legacy версии. 

• Place EXIF button on bottom bar – перемещает кнопку EXIF в нижнюю строку программы, 

освобождая место в окошке Image Metadata. Эта настройка вступает в силу после перезапуска 

программы. 

• Optional RAW decoders – параметры использования дополнительных (кроме LibRaw) декодеров 

RAW: 

• Adobe DNG SDK:  

i. Exotic DNG Formats: 8-битные файлы и floating point DNG 

ii. All DNG Formats: обычные (12-16-битные) файлы DNG 

• RawSpeed V1/V3 – декодер RawSpeed версий 1 (2014г) и версии 3 (современная версия), 

декодирует многие форматы значительно быстрее, чем LibRaw 

i. Use – использовать 

ii. Also for unknown cameras – использовать и для камер, не перечисленных явно как 

поддерживаемые 

iii. Check for warnings – сообщать о полученных при декодировании 

предупреждениях. 

• ExifTool Settings – параметры запуска утилиты ExifTool: 

• Path – путь до исполняемого файла ExifTool. Значение инициализируется при установке 

программы, но если у вас есть более подходящая вам версия (к примеру, более свежая), 

путь до этой версии задается в данном окне. 

• Command Line – параметры командной строки ExifTool. Помимо заданных в этом окне 

параметров, RawDigger неявно подставит еще параметр –h (HTML Output). 

• Check for updates: задает частоту проверки обновлений программой: на старте программы, либо 

раз в 1-3-7-15-30 дней. 

• Sampler Settings – настройки инструмента «замеров» 

• Sampler Size – выбор размера области замера из списка (2x2, 6x6, 10x10, 18x18, 34x34, 

66x66, 130x130, 258x258). 

Если вам нужен замер нестандартного размера, вы можете сделать ручную выборку 

(Selection), а затем сконвертировать ее в замер (Меню Selection -> Convert Selection to 

Sample). 

Настройки Sampler Size доступны только в версиях RawDigger Research и RawDigger Profile  
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Закладка Over/Under Exposure 
На этой закладке расположены настройки, отвечающие за определение областей передержки и 

недодержки. 

 

• Overexposure Detection – настройки определения переэкспозиции (выбитых каналов) 

o Auto (by Histogram) – переэкспозиция определяется по пикам на гистограмме в 

области насыщения. 
o Sensitivity – ширина области определения переэкспозиции  

▪ Значение в процентах (от полного диапазона значений, выдаваемых камерой) 

– задает область поиск острого пика на гистограмме 

▪ Full Well limited camera - включает альтернативный алгоритм определения 

области переэкспозиции «по мягкому пику». Этот режим предназначен для 

использования с камерами, где выдаваемые RAW-значения не ограничены на 

АЦП, а используется полный диапазон значений сенсора. 

▪ Auto OE Offset – позволяет изменить установленное автоматическим 

алгоритмом значение. Смещение задается в фотографических стопах, 

отрицательное смещение понижает границу детектирования переэкспозиции, 

положительое – увеличивает. 
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o Manual level, all channels – ручное задание уровня, одинакового для всех цветовых 

каналов. 
o Manual per channel – ручное задание уровня, отдельно для каждого канала. 
o Reset Manual levels on file load – при чтении файла будет произведено вычисление 

уровней насыщения по гистограмме и получившиеся значения – подставлены в 

качестве ручных уровней. 
o Use camera linearity limit if available: если из RAW-файла считано значение предела 

линейности, то данное значение будет использовано как граница при определении 

передержки. 

• Underexposure Detection – настройки определения областей недодержки 
o Offset from Saturation – уровень недодержки указывается в фотографических стопах 

относительно уровня передержки (насыщения). 

Если при установке уровня передержки использовалось смещение от автоматического 

уровня, это же смещение будет применено и к границе недодержки. 
o Manual level, all channels – уровень недодержки устанавливается в уровнях (сигнала), 

одинаковый для всех цветовых каналов. 
o Manual, per channel – индивидуальное задание уровня, отдельно для каждого канала. 

• Remember OvExp/UnExp checkbox settings – запоминает состояние режима показа областей 

переэкспозиции/недодержки. 
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Поддержка нестандартных камер 
RawDigger может быть использован для показа и анализа изображений с «инженерных» камер, 

сохраненных в виде «дампа данных сенсора» без каких-либо дополнительных метаданных. 

Ряд таких камер поддержан программой непосредственно (таблицы с нужными данными содержатся 

внутри RawDigger), для поддержки других (произвольных) сенсоров нужно добавить описание 

структуры данных сенсора в Windows Registry (на Windows) или OS X defaults (на Mac OS X). 

Для этого необходимо: 

Windows: подготовить registry-скрипт с содержанием подобным следующему: 

[HKEY_CURRENT_USER\Software\LibRaw LLC\CustomCameras] 

"Camera01"="24096096,4008,3006, 0, 0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3,0" 

И запустить его на исполнение в Windows Explorer. 

OS X: выполнить в терминале команду, подобную следующей (в одну строчку): 

defaults write com.libraw-llc.CustomCameras "Camera01" "24096096,4008,3006, 0, 

0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3" 

В обоих случаях: 

Camera01 (или Camera02 … Camera64) – «номер строчки» в таблице, всего поддерживается до 64 

камер. 

Строка «24096096,4008,3006, 0, 0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3,0» - описание формата данных 

камеры, состоящее из следующих 14 полей, разделенных запятыми (замечание для инженеров: 

формат этой строки полностью аналогичен строчке в таблице описания «дампов сенсора» в 

программе dcraw.c с тем уточнением, что формат CFA-фильтров задается в десятичном виде): 

1. Точный размер файла в байтах (в данном примере – 24096096). Это – единственный признак 

по которому RawDigger распознает «формат» данных, файлы другого размера будут 

проигнорированы. 

2. Ширина сенсора в пикселях. В этом поле пишется полная ширина, включающая «черную 

рамку» 

3. Высота сенсора в пикселях, включая черную рамку. 

4. Ширина черной рамки на левом краю сенсора (в пикселях) 

5. Ширина (высота) черной рамки сверху. 

6. Ширина черной рамки справа 

7. Ширина (высота) черной рамки снизу. 

8. Дополнительные параметры подпрограммы декодирования файла (см. ниже) 

9. Формат CFA байеровского фильтра, битовое поле принимающее одно из следующих 

значений: 

• 22 – BGGR 

• 97 – GRBG 
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• 73 – GBRG 

• 148 – RGGB 

• 180 - GMYC 

10. Количество неиспользуемых бит данных (например, если 14-битные данные записаны в 16-

битном формате) 

11. Дополнительные метаданные, битовая маска 

a. Бит 0 – искать .JPG-файл с тем же именем и считать EXIF-данные из него 

b. Бит 1 – фильтровать (усреднять соседние) для пикселей с нулевыми значениями 

c. Биты 2-4 – ориентация изображения (0=не поворачивать, 3=180, 5=90CCW, 6=90CW) 

12. Изготовитель камеры 

13. Модель камеры 

14. Смещение начала данных сенсора от начала файла (диапазон значений 0-65534, специальное 

значение 65535 означает «строки идут в обратном порядке»). 

Поддерживаются 8, 10, 12 и 16-битные форматы данных (количество бит рассчитывается как (размер 

файла минус смещение начала данных)/количество пикселей). 

В зависимости от битовой разрядности данных, восьмое поле («дополнительные параметры 

подпрограммы декодирования) может принимать следующие значения для 10-битных данных: 

• 1: используется хранение «4 пикселя в 5 байтах» 

• 0: используется хранение «6 пикселей в 8 байтах» 
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Список поддерживаемых камер 
Список поддерживаемых камер приведен ниже. RawDigger может работать и с некоторыми камерами 

не из данного списка, но полностью корректная работа не гарантируется.  Для неподдерживаемых 

камер скорее всего будут показываться некорректные цвета в режиме RGB-render, может 

некорректно определяться ширина маскированной области и т.п. 

• ASUS  

o ZenPhone4 

o ZenPhone6 

• AVT  

o F-080C 

o F-145C 

o F-201C 

o F-510C 

o F-810C 

• Adobe Digital Negative (DNG) 

• AgfaPhoto DC-833m 

• Alcatel 5035D 

• Apple  

o iPad Pro 

o iPhone SE 

o iPhone 6s 

o iPhone 6 plus 

o iPhone 7 

o iPhone 7 plus 

o iPhone 8 

o iPhone 8 plus 

o iPhone X 

o iPhone 12 Pro 

o iPhone 12 Pro Max 

o iPhone 13 

o iPhone 14 

o iPhone 14 Plus 

o iPhone 14 Pro 

o iPhone 14 Pro Max 

o iPhone 15 

o iPhone 15 Plus 

o iPhone 15 Pro 

o iPhone 15 Pro Max 

o QuickTake 100 

o QuickTake 150 

o QuickTake 200 

• AutelRobotics  

o XB015 

o XT705 (EVO II) 

o XL720 (EVO Lite+) 

• BQ Aquarius U 

• Baumer TXG14 
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• BlackMagic  

o Cinema Camera 

o Micro Cinema Camera 

o Pocket Cinema Camera 

o Production Camera 4k 

o URSA 

o URSA Mini 4k 

o URSA Mini 4.6k 

o URSA Mini Pro 4.6k 

• CLAUSS pix500 

• Canon  

o PowerShot 600 

o PowerShot A5 

o PowerShot A5 Zoom 

o PowerShot A50 

o PowerShot A410 (CHDK hack) 

o PowerShot A460 (CHDK hack) 

o PowerShot A470 (CHDK hack) 

o PowerShot A480 (CHDK hack) 

o PowerShot A530 (CHDK hack) 

o PowerShot A540 (CHDK hack) 

o PowerShot A550 (CHDK hack) 

o PowerShot A560 (CHDK hack) 

o PowerShot A570 IS (CHDK hack) 

o PowerShot A590 IS (CHDK hack) 

o PowerShot A610 (CHDK hack) 

o PowerShot A620 (CHDK hack) 

o PowerShot A630 (CHDK hack) 

o PowerShot A640 (CHDK hack) 

o PowerShot A650 IS (CHDK hack) 

o PowerShot A710 IS (CHDK hack) 

o PowerShot A720 IS (CHDK hack) 

o PowerShot A3300 IS (CHDK hack) 

o PowerShot D10 (CHDK hack) 

o PowerShot ELPH 130 IS / IXUS 140 / IXY 110F (CHDK hack) 

o PowerShot ELPH 160 / IXUS 160 (CHDK hack) 

o PowerShot Pro70 

o PowerShot Pro90 IS 

o PowerShot Pro1 

o PowerShot G1 

o PowerShot G1 X 

o PowerShot G1 X Mark II 

o PowerShot G1 X Mark III 

o PowerShot G2 

o PowerShot G3 

o PowerShot G3 X 

o PowerShot G5 

o PowerShot G5 X 

o PowerShot G5 X Mark II 
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o PowerShot G6 

o PowerShot G7 (CHDK hack) 

o PowerShot G7 X 

o PowerShot G7 X Mark II 

o PowerShot G7 X Mark III 

o PowerShot G9 

o PowerShot G9 X 

o PowerShot G9 X Mark II 

o PowerShot G10 

o PowerShot G11 

o PowerShot G12 

o PowerShot G15 

o PowerShot G16 

o PowerShot S2 IS (CHDK hack) 

o PowerShot S3 IS (CHDK hack) 

o PowerShot S5 IS (CHDK hack) 

o PowerShot SD300 / IXUS 40 / IXY Digital 50 (CHDK hack) 

o PowerShot SD750 / IXUS 75 / IXY Digital 90 (CHDK hack) 

o PowerShot SD900 / Digital IXUS 900 Ti / IXY Digital 1000 (CHDK hack) 

o PowerShot SD950 IS / Digital IXUS 960 IS / IXY Digital 2000 IS (CHDK hack) 

o PowerShot SD1200 IS / Digital IXUS 95 IS / IXY Digital 110 IS (CHDK hack) 

o PowerShot S30 

o PowerShot S40 

o PowerShot S45 

o PowerShot S50 

o PowerShot S60 

o PowerShot S70 

o PowerShot S90 

o PowerShot S95 

o PowerShot S100 

o PowerShot S110 

o PowerShot S120 

o PowerShot SX1 IS 

o PowerShot SX40 HS (CHDK hack, CR2) 

o PowerShot SX50 HS 

o PowerShot SX60 HS 

o PowerShot SX70 HS 

o PowerShot SX100 IS (CHDK hack) 

o PowerShot SX110 IS (CHDK hack) 

o PowerShot SX120 IS (CHDK hack) 

o PowerShot SX130 IS (CHDK hack) 

o PowerShot SX160 IS (CHDK hack) 

o PowerShot SX220 HS (CHDK hack) 

o PowerShot SX510 HS (CHDK hack) 

o PowerShot SX710 HS (CHDK hack) 

o PowerShot SX10 IS (CHDK hack) 

o PowerShot SX20 IS (CHDK hack) 

o PowerShot SX30 IS (CHDK hack) 

o EOS R 
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o EOS Ra 

o EOS RP 

o EOS R1 

o EOS R3 

o EOS R5 

o EOS R5 C 

o EOS R5 Mark II 

o EOS R6 

o EOS R6 Mark II 

o EOS R7 

o EOS R8 

o EOS R10 

o EOS R50 

o EOS R100 

o EOS D30 

o EOS D60 

o EOS 5DS 

o EOS 5DS R 

o EOS 5D 

o EOS 5D Mark II 

o EOS 5D Mark III 

o EOS 5D Mark IV 

o EOS 6D 

o EOS 6D Mark II 

o EOS 7D 

o EOS 7D Mark II 

o EOS 10D 

o EOS 20D 

o EOS 20Da 

o EOS 30D 

o EOS 40D 

o EOS 50D 

o EOS 60D 

o EOS 60Da 

o EOS 70D 

o EOS 77D / 9000D 

o EOS 80D 

o EOS 90D 

o EOS 100D / Rebel SL1 / Kiss X7 

o EOS 200D / Rebel SL2 / Kiss X9 

o EOS 250D / 200D II / Rebel SL3 / Kiss X10 

o EOS 300D / Digital Rebel / Kiss Digital 

o EOS 350D / Digital Rebel XT / Kiss Digital N 

o EOS 400D / Digital Rebel XTi / Kiss Digital X 

o EOS 450D / Digital Rebel XSi / Kiss X2 

o EOS 500D / Rebel T1i / Kiss X3 

o EOS 550D / Rebel T2i / Kiss X4 

o EOS 600D / Rebel T3i / Kiss X5 

o EOS 650D / Rebel T4i / Kiss X6i 
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o EOS 700D / Rebel T5i / Kiss X7i 

o EOS 750D / Rebel T6i / Kiss X8i 

o EOS 760D / Rebel T6S / 8000D 

o EOS 800D / Rebel T7i / Kiss X9i 

o EOS 850D / Rebel T8i / Kiss X10i 

o EOS 1000D / Digital Rebel XS / Kiss F 

o EOS 1100D / Rebel T3 / Kiss X50 

o EOS 1200D / Kiss X70 / REBEL T5 / Hi 

o EOS 1300D / Rebel T6 / Kiss X80 

o EOS 1500D / 2000D / Rebel T7 / Kiss X90 

o EOS 3000D / 4000D / Rebel T100 

o EOS D2000 

o EOS M 

o EOS M2 

o EOS M3 

o EOS M5 

o EOS M6 

o EOS M6 Mark II 

o EOS M10 

o EOS M50 / Kiss M 

o EOS M50 Mark II 

o EOS M100 

o EOS M200 

o EOS-1D C 

o EOS-1D X 

o EOS-1D X Mark II 

o EOS-1D X Mark III 

o EOS-1D 

o EOS-1D Mark II 

o EOS-1D Mark II N 

o EOS-1D Mark III 

o EOS-1D Mark IV 

o EOS-1Ds 

o EOS-1Ds Mark II 

o EOS-1Ds Mark III 

• Casio  

o QV-2000UX (secret menu hack) 

o QV-3000EX (secret menu hack) 

o QV-3500EX (secret menu hack) 

o QV-4000 (secret menu hack) 

o QV-5700 (secret menu hack) 

o QV-R41 

o QV-R51 

o QV-R61 

o EX-F1 

o EX-FC300S 

o EX-FC400S 

o EX-FH20 

o EX-FH25 
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o EX-FH100 

o EX-S20 / M20 

o EX-S100 

o EX-Z4 

o EX-Z50 

o EX-Z500 

o EX-Z55 

o EX-Z60 

o EX-Z75 

o EX-Z750 

o EX-Z8 

o EX-Z850 

o EX-Z1050 

o EX-ZR100 

o EX-Z1080 

o EX-ZR700 

o EX-ZR710 

o EX-ZR750 

o EX-ZR800 

o EX-ZR850 

o EX-ZR1000 

o EX-ZR1100 

o EX-ZR1200 

o EX-ZR1300 

o EX-ZR1500 

o EX-ZR3000 

o EX-ZR3100 

o EX-ZR3200 

o EX-ZR3500 

o EX-ZR3600 

o EX-ZR3700 

o EX-ZR4000 / 5000 

o EX-ZR4100 / 5100 

o EX-100 

o EX-100F 

o EX-100PRO 

o EX-10 

o EX-P505 (secret menu hack) 

o EX-P600 (secret menu hack) 

o EX-P700 (secret menu hack) 

• Contax N Digital 

• Creative PC-CAM 600 

• DJI  

o 4384x3288 

o Inspire 3 

o Mavic Air 

o Mavic Air 2 

o Mavic Air 2S 

o Mavic Air 3 
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o Mavic Mini 2 

o Mavic Mini 3 

o Mavic Mini 3 Pro 

o Mavic 2 Pro 

o Mavic 3 

o Mavic 3 Classic 

o Mavic 3 Pro 

o Osmo Action 

o Pocket 

o Phantom4 Pro/Pro+ 

o Zenmuse X5 

o Zenmuse X5R 

• DXO One 

• Digital Bolex  

o D16 

o D16M 

• Epson  

o R-D1 

o R-D1s 

o R-D1x 

• Eyedeas E1 

• Foculus 531C 

• FujiFilm  

o DBP for GX680 / DX-2000 

o E550 

o E900 

o F500EXR / F505EXR 

o F550EXR 

o F600EXR / F605EXR 

o F700 

o F710 

o F770EXR / F775EXR 

o F800EXR 

o F810 

o F900EXR 

o S2Pro 

o S3Pro 

o S5Pro 

o S20Pro 

o S1 

o S100FS 

o S5000 

o S5100 / S5500 

o S5200 / S5600 

o S6000fd / S6500fd 

o S7000 

o S9000 / S9500 

o S9100 / S9600 

o S200EXR / S205EXR 
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o SL1000 

o HS10/HS11 

o HS20EXR / HS22EXR 

o HS30EXR / HS33EXR / HS35EXR 

o HS50EXR 

o GFX 50S 

o GFX 50S II 

o GFX 50R 

o GFX 100 

o GFX 100 II 

o GFX 100S 

o GFX 100S II 

o X-Pro1 

o X-Pro2 

o X-Pro3 

o X-S1 

o X-S20 

o XQ1 

o XQ2 

o X100 

o X100F 

o X100S 

o X100T 

o X100V 

o X100VI 

o X10 

o X20 

o X30 

o X70 

o X-A1 

o X-A2 

o X-A3 

o X-A5 

o X-A7 

o X-A10 

o X-A20 

o X-E1 

o X-E2 

o X-E2S 

o X-E3 

o X-E4 

o X-M1 

o XF1 

o XF10 

o X-H1 

o X-H2 

o X-H2S 

o X-T1 

o X-S10 



RawDigger – руководство пользователя 

Стр. 68 из 90 © Copyright 2012-2023, LibRaw LLC, www.libraw.com 

o X-T1 Graphite Silver 

o X-T2 

o X-T3 

o X-T4 

o X-T5 

o X-T10 

o X-T20 

o X-T30 

o X-T30 II 

o X-T50 

o X-T100 

o X-T200 

o IS-1 

• GITUP  

o GIT2 

o GIT2P 

o G3 DUO (16:9 mode only) 

• Gione E7 

• GoPro  

o Fusion 

o HERO5 

o HERO6 

o HERO7 

o HERO8 

o HERO9 

o HERO10 

o HERO11 

o HERO12 

• Google  

o Pixel 

o Pixel XL 

o Pixel 3a 

o Pixel 4 XL 

o Pixel 4a (5G) 

o Pixel 5 

o Pixel 7a 

o Pixel 8 Pro 

o Pixel 9 Pro 

o Pixel 9 Pro XL 

o Pixel 9 Pro Fold 

• HTC  

o UltraPixel 

o MyTouch 4G 

o One (A9) 

o One (M9) 

o 10 

o U12 

• Hasselblad  

o H2D-22 
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o H2D-39 

o H3DII-22 

o H3DII-31 

o H3DII-39 

o H3DII-50 

o H3D-22 

o H3D-31 

o H3D-39 

o H4D-60 

o H4D-50 

o H4D-40 

o H4D-31 

o H5D-60 

o H5D-50 

o H5D-50c 

o H5D-40 

o H6D-100c 

o A6D-100c 

o CFV 

o CFV-50 

o CFV-50c 

o CFV II 50C 

o CFV-100c 

o CFH 

o CF-22 

o CF-31 

o CF-39 

o V96C 

o L1D-20c (DJI Mavic 2 Pro) 

o Lusso 

o Lunar 

o True Zoom 

o Stellar 

o Stellar II 

o HV 

o X1D 

o X1D II 50C 

o X2D 100C 

• Huawei  

o P8 Lite (PRA-LX1) 

o P9 (EVA-L09/AL00) 

o P10 (VTR-L09) 

o P10+ (VKY-L09) 

o P10 Lite (WAS-LX1A) 

o P20 (EML-L09) 

o P20 Lite (ANE-LX1) 

o P20 Pro (CLT-L29/L09) 

o P30 Pro (VOG-L29) 

o Honor6a 
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o Honor7a pro 

o Honor8 (FRD-L09) 

o Honor9 

o Honor10 

o Honor20 

o Honor View 10 (BKL-L09) 

o Honor View 20 (PCT-L29) 

o Honor 20 Pro (YAL-L41) 

o Mate8 (NXT-L29) 

o Mate10 (BLA-L29) 

o Mate20 Pro (LYA-L29) 

o Mate20 Lite (SNE-LX1) 

• ISG 2020x1520 

• Ikonoskop  

o A-Cam dII Panchromatic 

o A-Cam dII 

• Imacon  

o Ixpress 96, 96C 

o Ixpress 384, 384C (single shot only) 

o Ixpress 132C 

o Ixpress 528C (single shot only) 

• JaiPulnix  

o BB-500CL 

o BB-500GE 

• Kandao QooCam 8K 

• Kinefinity  

o KineMINI 

o KineRAW Mini 

o KineRAW S35 

• Kodak  

o DC20 

o DC25 

o DC40 

o DC50 

o DC120 

o DCS200 

o DCS315C 

o DCS330C 

o DCS420 

o DCS460 

o DCS460M 

o DCS460 

o DCS520C 

o DCS560C 

o DCS620C 

o DCS620X 

o DCS660C 

o DCS660M 

o DCS720X 
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o DCS760C 

o DCS760M 

o EOSDCS1 

o EOSDCS3 

o NC2000 

o ProBack 

o PB645C 

o PB645H 

o PB645M 

o DCS Pro 14n 

o DCS Pro 14nx 

o DCS Pro SLR/c 

o DCS Pro SLR/n 

o C330 

o C603 

o P850 

o P880 

o PIXPRO AZ901 

o PIXPRO S-1 

o Z980 

o Z981 

o Z990 

o Z1015 

o KAI-0340 

• Konica  

o KD-400Z 

o KD-510Z 

• LG  

o G3 

o G4 

o G5 (H850) 

o G6 

o V20 (F800K) 

o V20 (H910) 

o VS995 

• Leaf  

o AFi 5 

o AFi 6 

o AFi 7 

o AFi-II 6 

o AFi-II 7 

o AFi-II 10 

o AFi-II 10R 

o Aptus-II 5 

o Aptus-II 6 

o Aptus-II 7 

o Aptus-II 8 

o Aptus-II 10 

o Aptus-II 12 
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o Aptus-II 12R 

o Aptus 17 

o Aptus 22 

o Aptus 54S 

o Aptus 65 

o Aptus 65S 

o Aptus 75 

o Aptus 75S 

o Cantare 

o Cantare XY 

o CatchLight 

o CMost 

o Credo 40 

o Credo 50 

o Credo 60 

o Credo 80 

o DCB-II 

o Valeo 6 

o Valeo 11 

o Valeo 17 

o Valeo 17wi 

o Valeo 22 

o Valeo 22wi 

o Volare 

• Leica  

o C (Typ 112) 

o CL 

o C-Lux / CAM-DC25 

o Digilux 2 

o Digilux 3 

o Digital-Modul-R 

o D-LUX2 

o D-LUX3 

o D-LUX4 

o D-LUX5 

o D-LUX6 

o D-LUX7 

o D-Lux8 

o D-Lux (Typ 109) 

o M8 

o M8.2 

o M9 

o M10 

o M10-D 

o M10-P 

o M10-R 

o M10 Monochrom 

o M11 

o M11 Monochrom 
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o M (Typ 240) 

o M (Typ 262) 

o Monochrom (Typ 240) 

o Monochrom (Typ 246) 

o M-D (Typ 262) 

o M-E 

o M-P 

o R8 

o Q (Typ 116) 

o Q-P 

o Q2 

o Q2 Monochrom 

o Q3 

o Q3 43 

o S 

o S2 

o S3 

o S (Typ 007) 

o SL (Typ 601) 

o SL2 

o SL2-S 

o SL3 

o T (Typ 701) 

o TL 

o TL2 

o X1 

o X (Typ 113) 

o X2 

o X-E (Typ 102) 

o X-U (Typ 113) 

o V-LUX1 

o V-LUX2 

o V-LUX3 

o V-LUX4 

o V-LUX5 

o V-Lux (Typ 114) 

o X VARIO (Typ 107) 

• Lenovo a820 

• Logitech Fotoman Pixtura 

• Mamiya ZD 

• Matrix 4608x3288 

• Meizy MX4 

• Micron 2010 

• Minolta  

o RD175 / Agfa ActionCam 

o DiMAGE 5 

o DiMAGE 7 

o DiMAGE 7i 

o DiMAGE 7Hi 
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o DiMAGE A1 

o DiMAGE A2 

o DiMAGE A200 

o DiMAGE G400 

o DiMAGE G500 

o DiMAGE G530 

o DiMAGE G600 

o DiMAGE Z2 

o Alpha/Dynax/Maxxum 5D 

o Alpha/Dynax/Maxxum 7D 

• Motorola  

o PIXL 

o Moto G (5S) 

o Moto G7 Play 

• Nikon  

o D1 

o D1H 

o D1X 

o D2H 

o D2Hs 

o D2X 

o D2Xs 

o D3 

o D3s 

o D3X 

o D4 

o D4s 

o D40 

o D40X 

o D5 

o D50 

o D6 

o D60 

o D70 

o D70s 

o D80 

o D90 

o D100 

o D200 

o D300 

o D300s 

o D500 

o D600 

o D610 

o D700 

o D750 

o D780 

o D800 

o D800E 
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o D810 

o D810A 

o D850 

o D3000 

o D3100 

o D3200 

o D3300 

o D3400 

o D3500 

o D5000 

o D5100 

o D5200 

o D5300 

o D5500 

o D5600 

o D7000 

o D7100 

o D7200 

o D7500 

o Df 

o Z 5 

o Z 6 

o Z 6 II 

o Z 6 III 

o Z 7 

o Z 7 II 

o Z 8 

o Z 9 

o Z 30 

o Z 50 

o Z f 

o Z fc 

o 1 AW1 

o 1 J1 

o 1 J2 

o 1 J3 

o 1 J4 

o 1 J5 

o 1 S1 

o 1 S2 

o 1 V1 

o 1 V2 

o 1 V3 

o Coolpix 700 ("DIAG RAW" hack) 

o Coolpix 800 ("DIAG RAW" hack) 

o Coolpix 880 ("DIAG RAW" hack) 

o Coolpix 900 ("DIAG RAW" hack) 

o Coolpix 950 ("DIAG RAW" hack) 

o Coolpix 990 ("DIAG RAW" hack) 
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o Coolpix 995 ("DIAG RAW" hack) 

o Coolpix 2100 ("DIAG RAW" hack) 

o Coolpix 2500 ("DIAG RAW" hack) 

o Coolpix 3200 ("DIAG RAW" hack) 

o Coolpix 3700 ("DIAG RAW" hack) 

o Coolpix 4300 ("DIAG RAW" hack) 

o Coolpix 4500 ("DIAG RAW" hack) 

o Coolpix 5000 

o Coolpix 5400 

o Coolpix 5700 

o Coolpix 8400 

o Coolpix 8700 

o Coolpix 8800 

o Coolpix A 

o Coolpix A1000 

o Coolpix B700 

o Coolpix P330 

o Coolpix P340 

o Coolpix P950 

o Coolpix P6000 

o Coolpix P1000 

o Coolpix P7000 

o Coolpix P7100 

o Coolpix P7700 

o Coolpix P7800 

o Coolpix S6 ("DIAG RAW" hack) 

o Coolscan NEF 

• Nokia  

o 7 Plus 

o 8.3 5G 

o 9 

o N95 

o X2 

o 1200x1600 

o Lumia 930 

o Lumia 950 XL 

o Lumia 1020 

o Lumia 1520 

• OM  

o Digital Solutions OM-1 

o Digital Solutions OM-1 Mark II 

o Digital Solutions OM-5 

• Olympus  

o AIR A01 

o C-3030Z 

o C-5050Z 

o C-5060WZ 

o C-7070WZ 

o C-70Z / C-7000Z 
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o C-740UZ 

o C-770UZ 

o C-8080WZ 

o X200 / D-560Z / C-350Z 

o E-1 

o E-3 

o E-5 

o E-10 

o E-20 / E-20N / E-20P 

o E-30 

o E-300 

o E-330 

o E-400 

o E-410 

o E-420 

o E-450 

o E-500 

o E-510 

o E-520 

o E-600 

o E-620 

o E-P1 

o E-P2 

o E-P3 

o E-P5 

o E-P7 

o E-PL1 

o E-PL1s 

o E-PL2 

o E-PL3 

o E-PL5 

o E-PL6 

o E-PL7 

o E-PL8 

o E-PL9 

o E-PL10 

o E-PM1 

o E-PM2 

o E-M1 

o E-M1 Mark II 

o E-M1 Mark III 

o E-M1X 

o E-M10 

o E-M10 Mark II 

o E-M10 Mark III 

o E-M10 Mark IV 

o E-M5 

o E-M5 Mark II 

o E-M5 Mark III 
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o Pen-F 

o SP-310 

o SP-320 

o SP-350 

o SP-500UZ 

o SP-510UZ 

o SP-550UZ 

o SP-560UZ 

o SP-565UZ 

o SP-570UZ 

o Stylus 1 

o Stylus 1s 

o SH-2 

o SH-3 

o TG-4 

o TG-5 

o TG-6 

o TG-7 

o XZ-1 

o XZ-2 

o XZ-10 

• OmniVision  

o 4688 

o OV5647 

o OV5648 

o OV8850 

o 13860 

• OnePlus  

o 6 (A6003) 

o 6T 

o 7 Pro (GM1913) 

o 8 Pro (IN2023) 

o One 

o A3303 

o A5000 

• PARROT  

o Anafi 

o Bebop 2 

o Bebop Drone 

• Panasonic  

o DMC-CM1 

o DMC-FZ8 

o DMC-FZ18 

o DMC-FZ28 

o DMC-FZ30 

o DMC-FZ35 / FZ38 

o DMC-FZ40 / FZ42 / FZ45 

o DMC-FZ50 

o DMC-FZ70 / FZ72 
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o DC-FZ80 / FZ81 / FZ82 / FZ83 / FZ85 

o DMC-FZ100 

o DMC-FZ150 

o DMC-FZ200 

o DMC-FZ300 / FZ330 

o DMC-FZ1000 

o DC-FZ1000 II / FZ1000M2 / DC-FZ10002 

o DMC-FZ2000 / FZ2500 / FZH1 

o DMC-FX150 / FX180 

o DMC-G1 

o DMC-G10 

o DMC-G2 

o DMC-G3 

o DMC-G5 

o DMC-G6 

o DMC-G7 / G70 

o DMC-G8 / G80 / G81 / G85 

o DC-G9 

o DC-G9 Mark II 

o DC-G90 / G95 / G91 / G99 

o DC-G100 / G110 

o DMC-GF1 

o DMC-GF2 

o DMC-GF3 

o DMC-GF5 

o DMC-GF6 

o DMC-GF7 

o DC-GF10 / GF90 

o DMC-GH1 

o DMC-GH2 

o DMC-GH3 

o DMC-GH4 

o AG-GH4 

o DC-GH5 

o DC-GH5S 

o DC-GH5 Mark II 

o DC-GH6 

o DC-GH7 

o DMC-GM1 

o DMC-GM1s 

o DMC-GM5 

o DMC-GX1 

o DMC-GX7 

o DMC-GX8 

o DC-GX9 / GX7mkIII 

o DMC-GX80 / GX85, DMC-GX7mkII 

o DC-GX800 / GX850, DC-GF9 

o DMC-L1 

o DMC-L10 
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o DMC-LC1 

o DMC-LF1 

o DMC-LX1 

o DMC-LX2 

o DMC-LX3 

o DMC-LX5 

o DMC-LX7 

o DMC-LX9 / LX10 / LX15 

o DMC-LX100 

o DC-LX100M2 

o DC-S1 

o DC-S1H 

o DC-S1R 

o DC-S5 

o DC-S5 MkII 

o DC-S9 

o DMC-ZS40, DMC-TZ60 / TZ61 

o DMC-ZS50, DMC-TZ70 / TZ71 

o DMC-ZS60, DMC-TZ80 / TZ81 / TZ82 / TZ85 

o DC-ZS70, DC-TZ90 / TZ91 / TZ92 / TZ93 

o DC-ZS80, DC-TZ95 / TZ96 / TZ97 

o DMC-ZS100 / ZS110, DMC-TZ100 / TZ101 / TZ110, DMC-TX1 

o DC-ZS200 / ZS220, DC-TZ200 / TZ202 / TZ220, DC-TX2 

o DC-ZS200D / ZS220D, DC-TZ200D / TZ202D / TZ220D 

• Pentax  

o *ist D 

o *ist DL 

o *ist DL2 

o *ist DS 

o *ist DS2 

o K10D 

o K20D 

o K100D 

o K100D Super 

o K110D 

o K200D 

o K2000/K-m 

o KF 

o KP 

o K-x 

o K-r 

o K-01 

o K-1 

o K-1 Mark II 

o K-3 

o K-3 Mark II 

o K-3 Mark III 

o K-3 Mark III Monochrome 

o K-30 
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o K-5 

o K-5 II 

o K-5 IIs 

o K-50 

o K-500 

o K-7 

o K-70 

o K-S1 

o K-S2 

o MX-1 

o Q 

o Q7 

o Q10 

o QS-1 

o Optio S (secret menu or hack) 

o Optio S4 (secret menu or hack) 

o Optio 33WR (secret menu or hack) 

o Optio 750Z (secret menu or hack) 

o 645D 

o 645Z 

• PhaseOne  

o IQ140 

o IQ150 

o IQ160 

o IQ180 

o IQ180 IR 

o IQ250 

o IQ260 

o IQ260 Achromatic 

o IQ280 

o IQ3 50MP 

o IQ3 60MP 

o IQ3 80MP 

o IQ3 100MP 

o IQ3 100MP Trichromatic 

o IQ4 150MP 

o LightPhase 

o Achromatic+ 

o H 10 

o H 20 

o H 25 

o P 20 

o P 20+ 

o P 21 

o P 25 

o P 25+ 

o P 30 

o P 30+ 

o P 40+ 
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o P 45 

o P 45+ 

o P 65 

o P 65+ 

• Photron BC2-HD 

• Pixelink A782 

• Polaroid x530 

• PtGrey GRAS-50S5C 

• RaspberryPi  

o Camera 

o Camera V2 

o HQ Camera 

• Realme 3 Pro 

• Ricoh  

o GR 

o GR II 

o GR III 

o GR IIIx 

o GR Digital 

o GR Digital II 

o GR Digital III 

o GR Digital IV 

o Caplio GX100 

o Caplio GX200 

o GXR Mount A12 

o GXR GR Lens A12 50mm F2.5 Macro 

o GXR GR Lens A12 28mm F2.5 

o GXR Ricoh Lens A16 24-85mm F3.5-5.5 

o GXR Ricoh Lens S10 24-72mm F2.5-4.4 VC 

o GXR Ricoh Lens P10 28-300 mm F3.5-5.6 VC 

• Rollei d530flex 

• RoverShot 3320af 

• SMaL  

o Ultra-Pocket 3 

o Ultra-Pocket 4 

o Ultra-Pocket 5 

• STV680 VGA 

• SVS SVS625CL 

• Samsung  

o EX1 / TL500 

o EX2F 

o GX-1L 

o GX-1S 

o GX10 

o GX20 

o Galaxy Nexus 

o Galaxy Note 9 

o Galaxy NX (EK-GN120) 

o Galaxy S3 
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o Galaxy S6 (SM-G920F) 

o Galaxy S7 

o Galaxy S7 Edge 

o Galaxy S8 (SM-G950U) 

o Galaxy S9 (SM-G960F) 

o Galaxy S9+ (SM-G965U / 965F) 

o Galaxy S10 (SM-G973F) 

o Galaxy S10+ (SM-G975U) 

o Galaxy S22 Ultra (SM-S908B) 

o Galaxy S23+ 

o Galaxy S23 Ultra 

o NX1 

o NX5 

o NX10 

o NX11 

o NX100 

o NX1000 

o NX1100 

o NX20 

o NX200 

o NX210 

o NX2000 

o NX30 

o NX300 

o NX300M 

o NX3000 

o NX500 

o NX mini / NXF1 

o Pro815 

o WB550 / WB560 / HZ15W 

o WB2000 / TL350 

o WB5000 / HZ25W 

o S85 (hacked) 

o S850 (hacked) 

• Sarnoff 4096x5440 

• Seitz  

o 6x17 

o Roundshot D3 

o Roundshot D2X 

o Roundshot D2Xs 

• Sigma  

o fp 

o fp L 

o SD9 (raw decode only) 

o SD10 (raw decode only) 

o SD14 (raw decode only) 

o SD15 (raw decode only) 

o SD1 

o SD1 Merrill 
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o DP1 

o DP1 Merrill 

o DP1S 

o DP1X 

o DP2 

o DP2 Merrill 

o DP2S 

o DP2X 

o DP3 Merrill 

o dp0 Quattro 

o dp1 Quattro 

o dp2 Quattro 

o dp3 Quattro 

o sd Quattro 

o sd Quattro H 

• Sinar  

o eMotion 22 

o eMotion 54 

o eSpirit 65 

o eMotion 75 

o eVolution 75 

o 3072x2048 (Sinarback 23) 

o 4080x4080 (Sinarback 44) 

o 4080x5440 

o STI format 

o Sinarback 54 

• Skydio 2+ 

• Sony  

o ILCE-1 (A1) 

o ILCE-7 (A7) 

o ILCE-7M2 (A7 II) 

o ILCE-7M3 (A7 III) 

o ILCE-7M4 (A7 IV) 

o ILCE-7C (A7C) 

o ILCE-7CR (A7CR) 

o ILCE-7CM2 (A7C II) 

o ILCE-7R (A7R) 

o ILCE-7RM2 (A7R II) 

o ILCE-7RM3 (A7R III) 

o ILCE-7RM3A (A7R IIIA) 

o ILCE-7RM4 (A7R IV) 

o ILCE-7RM4A (A7R IVA) 

o ILCE-7RM5 (A7R V) 

o ILCE-7S (A7S) 

o ILCE-7SM2 (A7S II) 

o ILCE-7SM3 (A7S III) 

o ILCE-9 (A9) 

o ILCE-9M2 (A9 II) 

o ILCE-9M3 (A9 III) 
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o ILCA-68 (A68) 

o ILCA-77M2 (A77-II) 

o ILCA-99M2 (A99-II) 

o ILCE-3000 / 3500 

o ILCE-5000 

o ILCE-5100 

o ILCE-6000 

o ILCE-6100 

o ILCE-6300 

o ILCE-6400 

o ILCE-6500 

o ILCE-6600 

o ILCE-6700 

o ILCE-QX1 / UMC-R10C 

o ILX-LR1 

o DSC-F828 

o DSC-HX95 

o DSC-HX99 

o DSC-R1 

o DSC-RX0 

o DSC-RX0 II 

o DSC-RX1 

o DSC-RX1R 

o DSC-RX1R II 

o DSC-RX10 

o DSC-RX10 II 

o DSC-RX10 III 

o DSC-RX10 IV 

o DSC-RX100 

o DSC-RX100 II 

o DSC-RX100 III 

o DSC-RX100 IV 

o DSC-RX100 V 

o DSC-RX100 VA 

o DSC-RX100 VI 

o DSC-RX100 VII 

o DSC-V3 

o DSLR-A100 

o DSLR-A200 

o DSLR-A230 

o DSLR-A290 

o DSLR-A300 

o DSLR-A330 

o DSLR-A350 

o DSLR-A380 / A390 

o DSLR-A450 

o DSLR-A500 

o DSLR-A550 

o DSLR-A560 
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o DSLR-A580 

o DSLR-A700 

o DSLR-A850 

o DSLR-A900 

o NEX-3 

o NEX-3N 

o NEX-5 

o NEX-5N 

o NEX-5R 

o NEX-5T 

o NEX-6 

o NEX-7 

o NEX-C3 

o NEX-F3 

o NEX-VG20 

o NEX-VG30 

o NEX-VG900 

o SLT-A33 

o SLT-A35 

o SLT-A37 

o SLT-A55(V) 

o SLT-A57 

o SLT-A58 

o SLT-A65(V) 

o SLT-A77(V) 

o SLT-A99(V) 

o XCD-SX910CR 

o IMX135-mipi 13mp 

o IMX135-QCOM 

o IMX072-mipi 

o IMX214 

o IMX219 

o IMX230 

o IMX298-mipi 16mp 

o IMX219-mipi 8mp 

o Xperia 5 II (XQ-AS52) 

o Xperia L 

o Xperia 1 III 

o Xperia 1 IV (XQ-CT54) 

o ZV-1 (DCZV1/B) 

o ZV-1M2 

o ZV-E1 

o ZV-E10 

o ZV-E10 II 

• Vivo X51 5G (V2006) 

• Xiaomi  

o 12S Ultra (2203121C) 

o 13 Pro (2210132G) 

o MI3 
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o MI 8 

o MI 9 Lite 

o MI MAX 

o POCO M3 

o RedMi Note3 Pro 

o RedMi Note7 

o RedMi Note 8T 

o FIMI X8SE 

• Xiaoyi YIAC3 (YI 4k) 

• YUNEEC  

o CGO3 

o CGO3P 

o CGO4 

• Yi M1 

• Zeiss ZX1 

• Zenit M 
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Копирайты и благодарности 
В программе RawDigger используются библиотеки Qt 4.8/5.12, LibRaw, LibXML2, LibJPEG-turbo, libtiff, 

RawSpeed  и runtime-библиотека Microsoft Visual Studio 2010. 

В поставку программы включена утилита ExifTool 

Все упомянутые в руководстве торговые марки являются собственностью их владельцев. 

ExifTool 

Copyright 2003-2019, Phil Harvey 

This is free software; you can redistribute it and/or modify it under the same terms as Perl itself. 

ExifTool использована на условиях Perl Artistic License, см. файл exiftool-artistic-license.html в каталоге 

программы. 

LibRaw  

LibRaw: Raw images processing library 

Copyright (C) 2008-2019 LibRaw LLC (http://www.libraw.org, info@libraw.org) 

Qt 4.8 (Legacy version) 

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies). 

Contact: http://www.qt-project.org/legal 

Библиотека Qt использована на условиях GNU LESSER GENERAL PUBLIC LICENSE 2.1, см. Файл 

LICENSE.LGPL в каталоге программы RawDigger. 

Qt использует ряд свободно распространяемых библиотек, их список и копирайты приведены в файле 

QT-Third-Party-Licenses.rtf, находящемся в каталоге программы RawDigger. 

Qt 5.12 

Copyright (C) 2016 The Qt Company Ltd. 

Contact: https://www.qt.io/licensing/ 

Библиотека Qt использована на условиях GNU LESSER GENERAL PUBLIC LICENSE 2.1, см. Файл 

LICENSE.LGPL в каталоге программы RawDigger. 

RawSpeed library 

RawSpeed - RAW file decoder. 

Copyright (C) 2009 Klaus Post 

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser 

General Public License as published by the Free Software Foundation; either  version 2 of the License, or (at 

your option) any later version. 

http://www.qt-project.org/legal
https://www.qt.io/licensing/
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This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the 

implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU Lesser 

General Public License for more details. 

LibJPEG-turbo 

Copyright 2009 Pierre Ossman <ossman@cendio.se> for Cendio AB 

Copyright 2010 D. R. Commander 

Based on x86 SIMD extension for IJG JPEG library - version 1.02 

Copyright (C) 1999-2006, MIYASAKA Masaru. 

This software is provided 'as-is', without any express or implied warranty.  In no event will the authors be 

held liable for any damages arising from the use of this software. Permission is granted to anyone to use this 

software for any purpose, including commercial applications, and to alter it and redistribute it 

freely, subject to the following restrictions: 

1. The origin of this software must not be misrepresented; you must not    claim that you wrote the original 

software. If you use this software    in a product, an acknowledgment in the product documentation would 

be    appreciated but is not required. 

2. Altered source versions must be plainly marked as such, and must not be  misrepresented as being the 

original software. 

3. This notice may not be removed or altered from any source distribution. 

LibTIFF 

Copyright (c) 1988-1997 Sam Leffler 

Copyright (c) 1991-1997 Silicon Graphics, Inc. 

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is 

hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear 

in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon 

Graphics may not be used in any advertising or publicity relating to the software without the specific, prior 

written permission of Sam Leffler and Silicon Graphics. 

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,  EXPRESS, IMPLIED OR 

OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY  WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE.   

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 

INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM 

LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON 

ANY THEORY OF  LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE. 
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LibJPEG 

The Independent JPEG Group's JPEG software 

This distribution contains a release of the Independent JPEG Group's free JPEG software.  You are welcome 

to redistribute this software and to use it for any purpose, subject to the conditions under LEGAL ISSUES, 

below. 

This software is the work of Tom Lane, Guido Vollbeding, Philip Gladstone, Bill Allombert, Jim Boucher, Lee 

Crocker, Bob Friesenhahn, Ben Jackson, Julian Minguillon, Luis Ortiz, George Phillips, Davide Rossi, Ge' 

Weijers, and other members of the Independent JPEG Group. 

IJG is not affiliated with the official ISO JPEG standards committee. 

LibXML2 

Copyright (C) 1998-2003 Daniel Veillard.  All Rights Reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 

documentation files (the "Software"), to deal in the Software without restriction, including without 

limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the 

Software, and to permit persons to whom the Software is furnished to do so, subject to the following 

conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions 

of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 

BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT.  IN NO EVENT SHALL THE DANIEL VEILLARD BE LIABLE FOR ANY CLAIM, DAMAGES OR 

OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF 

OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise 

to promote the sale, use or other dealings in this Software without prior written authorization from  

MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES 

Copyright 2010 Microsoft Corp. 

Рантайм-библиотеки Microsoft распространяются на условиях, описанных в файле MSVC-Runtime-

EULA.rtf, находящемся в каталоге программы RawDigger. 


